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Welcome!
Welcome to the Cubase Demo Getting Started on-line documentation! 

Please use one of the methods described below to quickly find the desired informa-
tion:

• Use the Table of Contents provided by the Adobe Acrobat Reader pro-
gram.

• Use the Adobe Acrobat Reader Search function.
• Click on a cross-reference (green text) to jump to the respective topic.

It is of course possible to print out this document or parts of it.

Additional Information on how to use the Adobe Acrobat Reader program can be 
found in its on-line Help.

What this document contains
This chapter is an excerpt from the Cubase “Getting Started” book . It will help you 
get started with the programs basic capabilities and with MIDI recording and edit-
ing.

● Since this is an excerpt from a bigger book, some references to other texts and 
chapters will not be accurate.
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Why you should read this Chapter
In this chapter, none of the actual features of Cubase are described. Instead, the 
chapter contains information about the general methods you need to employ when 
using Cubase plus some useful terminology. These methods are the same in every 
part of the program, no matter if you are making a basic recording or using Cubase 
on its most advanced level. To make your working with Cubase as effective as pos-
sible, please take your time to read this chapter.
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Cubase Building Blocks
When you record your playing on a MIDI keyboard, each 
note appears in Cubase as an Event.

Events are packed into 
“containers” called Parts.

Parts reside on Tracks. You will have one Track 
for each instrument in your MIDI “orchestra”. 
The Parts and Tracks make up an Arrangement.

An Arrangement with five Tracks, 
each containing several Parts.
- 7 - 



 

You can work on a number of Arrangements 
simultaneously. Together they form a Song.
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Toolboxes

What are the Tools?

When you are working with Cubase, you need different tools in different situations. 
You may for example want to input notes using a Pencil tool, or delete notes using 
an Eraser tool. There are a lot of other tools as well.

Some examples of tools

What are the Toolboxes?

The various tools you may need in a certain situation, are gathered in a Toolbox. 
This is essentially a “box” containing an icon for each tool. Each of the main win-
dows in Cubase has its own Toolbox, containing the respective necessary tools. All 
the main tools are described in the chapters “An Introduction to Arrangement Edit-
ing” and “An Introduction To MIDI Editing”.
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Some examples of Toolboxes

Selecting a Tool from a Toolbox

1. Press the right mouse button.
Make sure the pointer is not positioned over a numerical value field, as this 
will instead increase the value (see page 17).

2. The Toolbox appears.
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3. Move the pointer to the tool you want to select, and release the mouse 
button.
The Toolbox disappears and the pointer takes on the shape of the selected 
tool.

Pop-Up Menus
Throughout the program you will select values from pop-up menus. These differ a 
bit from the regular “menu bar menus”. Pop-up menus may be located anywhere in 
a window, and are not on a menu bar. But, selecting is done identically from all 
menus, pop-up or regular.

Press the mouse button with 
the pointer positioned on the 
small triangle...

...to pull down a pop-up menu.
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About Positions, Lengths and Resolution
Cubase works with a resolution of 384 fractions (or ticks) per quarter note. You will 
often work with position values in the Arrange window and in the MIDI editors. 
Positions in Cubase are displayed in one of two formats: 

Meter positions

The beginning of the Song, 
displayed as a Meter position.
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Meter Positions and Lengths are divided into Bars, Beats (quarter notes) and Ticks. 
For example, a note length of three bars, one quarter note and a sixteenth would be 
displayed like this: “3.1.96”. In the table below, some note values are displayed as 
ticks:

Note Value Number of Ticks

Whole note 1536

Half note 768

Quarter note 384

Dotted eighth note 288

Eighth note 192

Eighth note triplet 128

Dotted sixteenth note 144

Sixteenth note 96

Sixteenth note triplet 64
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Time positions

Time Positions and lengths are shown as “hours: minutes:seconds:frames”. How 
many frames there are to each second depends on the frame rate, as set in the Syn-
chronization dialog box. Common values are 25 and 30. See the “Synchronization” 
chapter.

Setting Values

Different types of values

There are four basic kinds of values displayed in Cubase:

• Meter Positions
• Time Positions
• Note Pitches
• “Other” values

The beginning of the Song, 
displayed as a Time position.
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As explained above, positions and lengths can be displayed as Meter values or as 
Time Positions. Other values, such as tempo, velocity etc, are displayed as a 
number, sometimes with decimals. Some values may be negative.

Some different values.

How to change a value by typing

You can double click on a value field. The value is highlighted, and you can type in 
a new value and press [Return]. You can use the numeric key pad as well as the nor-
mal keyboard in most cases.

If you are editing a value that is “segmented”, such as a Song Position or a decimal 
number, you can use spaces, dots, commas or any character that is not a number, to 
separate the numerals. However, you don’t have to type in all the numerals. If you 
just type in a single number, you will change the largest numeral in the segmented 
value, and all the lesser numerals will be set to their lowest values. See the picture 
on the next page:
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If you are editing a pitch (note number), there are two ways of typing it: as a note 
name (a letter followed by a number and maybe a #-sign) or as a MIDI note number 
(a number from 0 to 127, where 0 is the lowest note).

Double clicking on this 
value (Song Position)...

...brings up a value 
box.

If you type a single 
value and press 

...the lesser numerals get 
their lowest values 

You may enter a MIDI note 
number, for example 37...

...but Cubase will display the 
name of the note (here C#1).
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How to change a value using the Mouse

You can use the mouse to either change a value by single steps or continuously 
scroll it up or down.

Method 1

1. Position the pointer over the value you want to change.

2. Click with the left or right mouse button
The left button decreases the value, the right button increases it. For each 
click the value changes one step.

3. Continue clicking until you have reached the desired value.

• If you hold down [Shift] while clicking, the value will change in larger 
steps (often steps of ten).

Method 2

1. Press and hold down one of the mouse buttons with the pointer over the 
value.
The value will scroll up or down depending on which button you press (the 
left button decreases the value and the right button increases it).

2. Release the button when you have reached the desired value.
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• If you hold down [Shift] while using the mouse, the value will scroll in 
larger steps (often steps of ten).

Changing a value by dragging

If you hold down the [Control] key on the computer keyboard, you can click on a 
value and drag the mouse up or down with the button pressed. The whole screen 
will then act like an invisible scroll bar or fader, which you can use to change the 
value.

If you press [Control], click on a value 
and keep the mouse button pressed...

...you can “drag the 
value” up...

...or down.
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About changing “segmented” values

If you are using the mouse to change a “segmented” value such as a position or a 
decimal number, you can change any one of the “segments” individually. In a posi-
tion value for example, you can change the bar, beat and tick values independently, 
just by positioning the pointer at the right numeral.

Clicking on the “Beats” value...

...will change this value o
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Naming
You can give names to Tracks, Parts and many other items in Cubase. To edit a 
name just double click on it. The text gets highlighted and you can type in the 
changes you want to make. You can use the arrow and [Backspace] keys, just as in 
any text-editing program.

Window Techniques
Cubase is a Windows-program, which means standard “Windows procedures” ap-
ply. You may move, resize, scroll and close windows using standard procedures. If 
you use Windows 95, please refer to the “Using Windows 95” Readme file on one 
of the program disks, for information about special windows procedures. There are 
also a couple of special features:

Double clicking on the name... 

...highlights it and makes it ready to
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Changing the Magnification

In the Arrange window and most of the editors, a plus and a minus sign appear on 
each scroll-bar. Click on the plus sign to increase magnification. The minus sign 
will decrease magnification.

The plus and minus sign on the left/right scroll bar change the horizontal magnifi-
cation. The signs on the up/down scroll bar change the vertical magnification. If 
you click on a plus or minus sign and keep the mouse button pressed, the magnifi-
cation factor will change continuously, allowing you to zoom in or out.

You can also change the magnification from the computer keyboard, using the fol-
lowing keys:

[G] Decrease horizontal magnification.

[H] Increase horizontal magnification.

[Shift]-[G] Decrease vertical magnification.

[Shift]-[H] Increase vertical magnification.

The vertical magnifying buttons

The horizontal magnifying buttons
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Dividers

Some of the windows in Cubase are divided into two or more sections. The “bor-
ders” between the sections are called Dividers. If you position the pointer on a Di-
vider, the pointer takes on the shape of a hand. You can then click on the Divider 
and drag it in the direction of one of the sections. This way, you will shrink that sec-
tion and enlarge the other.

Dragging the Divider in the Arrange Window.
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The Transport Bar

This is a special window, that among other things contain the transport controls: 
Play, Stop, Record, Rewind and Fast Forward. These work much like the controls 
on a tape recorder. Read more about the Transport Bar in the “Playback, Tempo and 
the Transport Bar” chapter.

The Transport Bar differs from standard Windows. It doesn’t have a title bar (the 
area at the top of a window, used for dragging it around on the screen). Instead you 
can use the “handles”, at each side of the window, to move the Transport Bar.

Dialog Boxes
When you select a function from a menu, sometimes a dialog box appears. This is 
a type of window, but it can’t be moved or resized. After you have input the neces-
sary information using the mouse and/or keyboard you close the dialog box by 
clicking on a button called “OK”, “Do It!” or something similar, or by pressing 
[Return] on the computer keyboard.

Even when you have a dialog box open you can still use the numeric key pad for the 
functions on the Transport Bar (Start, Stop and so on). 
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Using the Computer Keyboard
When you are working with Cubase, the computer keyboard has several different 
uses:

Transport Controls

The Transport functions (such as Play, Stop, Record and so on) can all be managed 
from the computer keyboard. The keyboard commands for these functions are lo-
cated on the numeric key pad, to the right on the computer keyboard. See page 98 in 
this book.

Keyboard Shortcuts

Many of the items in Cubase’s menus have a computer keyboard equivalent - a 
“shortcut”. These keyboard shortcuts generally use the keys on the main computer 
keyboard, to the left. 
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How Keyboard Commands are displayed in this Manual

The following list shows how the “special” keys on the computer keyboard are dis-
played in this manual.

When the text says something like “press [Control]-[T]” this means that you should 
hold down the control key on the computer keyboard and press T once.

In this manual: On some keyboards:

[Shift]

[Alternate] Alt

[Alt Gr] (should not be confused with Alternate)

[Control] Ctrl

[Tab]

[Return]

[Backspace]
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Cutting, Copying and Pasting
You can use the standard commands, Cut, Copy and Paste, to rearrange Parts, notes 
and other Events. These commands can be found on the Edit menu, and have the 
keyboard equivalents [Control]-[X], [Control]-[C] and [Control]-[V] respectively. 
Cutting, Copying and Pasting is the main way of moving and duplicating notes be-
tween different Parts or between the different Arrangements in a Song.
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Cutting

The Cut command takes the selected Parts or Events and removes them from where 
they were. Instead they are put in a temporary, non-visible location called the Clip-
board.

Selecting a Part and Cutting it...

...removes it from 
where it was...

...and puts it on the Clipboard.
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Copying

The Copy command takes the selected Parts or Events, copies them and puts the 
copy on the Clipboard. The difference between Cut and Copy is that nothing is re-
moved when using Copy.

● Only the last item(s) Cut or copied are stored in the Clipboard. There is only 
one Clipboard, shared by Cut and Copy.

Selecting a Part and Copying it...

The original Part is left where it was.

...makes a duplicate of the 
Part and puts the duplicate 
on the Clipboard.
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This means that anything already on the Clipboard will be replaced if you Cut or 
Copy again. 

Pasting

The Paste command puts the contents of the Clipboard back into the selected win-
dow, in the same window as they were Cut or Copied from, or another. These are 
the rules:

Let’s for example say that you Cut 
or Copy two notes from an editor. 
These are put on the Clipboard.

If you then Cut or Copy something 
else (a Part, some other notes, etc)...

...the two notes on the Clipboard 
will be replaced by these last 
Cut or Copied Events.
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• If the Clipboard contains Events Cut/Copied from an editor, you can only 
Paste them into an editor (the one they came from or another one). You 
can’t Paste editor Events into the Arrange Window.

• If the Clipboard contains Parts Cut/Copied from the Arrange window, 
you can only Paste them into the Arrange window. 

• You can Paste the same contents from the Clipboard as many times as you 
like. Data is copied from the Clipboard, not moved from it.

Pasting will make a 
duplicate of the contents 
of the Clipboard and put 
the duplicate where you 
want it.

The contents of the 
Clipboard are still 
there.
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● Cutting, Copying and Pasting is the way to move Events from one Part to an-
other. There is only one Clipboard for Events, and it is shared by all the edi-
tors, so that notes and other Events can be moved from one Part to the next.

Undo
Cubase has a very wide-ranging Undo function. This means that if you regret your 
last action, you can Undo it. This is very helpful when something doesn’t turn out 
as intended. Remember that it is only the last action that can be undone.

You Undo an action by selecting “Undo” from the Edit Menu, or by pressing [Con-
trol]-[Z] on the computer keyboard.

If you wish to “Undo the Undo”, this is possible. The menu text changes to “Redo” 
after an Undo (for example “Redo Delete”). If the menu item is grey, nothing can 
be undone.

Often the menu item Undo tells 
you what will be undone at any 
given moment. In this case, 
“Undo Delete” means the last 
deletion will be undone.
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Real Time
Cubase is a true real-time program. It has sophisticated multi-tasking procedures 
that let you do almost anything (like loading from, and saving to disk) without in-
terrupting the music.

In some instances the notes sounding at the moment have to be cut off, but timing is 
never affected.

● Generally, don’t turn off playback or recording just because you want to try a 
command or a function, just do it!
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Getting Help
Cubase supports the Windows Help system. This means that you can always get 
help about the procedures and functions in the program while you run it. There are 
three principal ways to invoke the Help system:

• By selecting “Help” on the Help menu.
This will open a Help window, displaying information about the active win-
dow. This can also be done by pressing [F1] on the computer keyboard.

● To get help about a specific menu item, open the menu, mark the item with 
the up and down arrow keys and press [F1].

• By selecting “Contents” on the Help menu.
This will open the list of contents of the complete Help file. If you click on 
one of its entries, the appropriate information will be shown.

• By clicking on a Help button.
All dialog boxes in Cubase have a Help button. If you click on this, the Help 
window is opened, showing information related to the dialog box.

● For help on the Windows Help system, select Using Help on the Help menu.
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3

Basic MIDI Recording 3
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Preparations
Before you can actually press the Record button, there are a number of things you 
have to check and set up. It may seem like a lot the first time you do it. Once you’re 
started, however, you’ll note how fast you’re laying down Tracks with Cubase.
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Launching Cubase

When Cubase is first launched, an empty Arrangement with a number of MIDI 
Tracks is loaded automatically. We suggest you use this when you perform your 
first recordings. Later you can customize the way Cubase is “configured” on start-
up.

The default start-up Arrange window with sixteen empty Tracks.

If you don’t see any Tracks just press [Command]-[T] a few times to create some.
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Setting up the MIDI equipment

Hopefully you have already set up and acquainted yourself with your MIDI equip-
ment (as described in the Installation chapter), but let’s step through a quick check 
list to make sure:

• You need to have the MIDI Out of the instrument you’re actually playing con-
nected to a MIDI In on your computer.

• You need to have a MIDI Out on the computer connected to the instrument 
that is to produce the sound for the Track.

• If you’re using the same instrument for playing and for playing back (if you for 
example are using a single keyboard synthesizer) you should set it to Local 
Off (see the Instruments operation manual for information on how to do this).

• Pull down the Options menu and select “MIDI Setup”. In the dialog box that 
appears, make sure MIDI Thru is enabled.

There’s one rare occasion where Thru should be turned off, see page 42.

The MIDI Setup dialog box.

In most setups, MIDI Thru 
should be enabled.
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Selecting and naming a Track

The next step is to select a Track to record on:

1. If you have an empty MIDI Track in the Arrangement on screen, click on 
its name so that it turns black.

2. If you don’t have an empty Track, select Create Track from the Structure 
menu and make sure the new Track is a MIDI Track (see page 127).

This symbol indicates 
that the Track is a 
MIDI Track
- 39 - 



3. Double click on the current name and type in your own.

Double click on the name, 
and enter a new one....

...press [Return] and the 
new name appears.
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Setting MIDI Channel and Output

Setting the MIDI Channel in the Instrument

Most MIDI synthesizers can play several sounds at the same time, each on a differ-
ent MIDI Channel. This is the key to playing back several sounds (bass, piano etc.) 
from the same instrument.

Some devices (such as General MIDI compatible sound modules) always receive 
on all 16 MIDI Channels. If you have such an instrument, there’s no specific setting 
you need to make in the instrument.

On other instruments you will have to use the front panel controls to set up a 
number of “Parts”, “Timbres” or similar so that they receive on one MIDI Channel 
each. See the manual that came with your instrument for more information.
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Setting the MIDI Channel and Output in the Track List

1. Set the Chn column for the Track to the same MIDI Channel as you just 
decided to use on the synthesizer.

2. Drag the Track list Divider all the way to the right, to reveal the Output 
column.

Dragging the Divider...

...reveals the Output column
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3. Make sure the Track you plan to record on is set to the MIDI Output that 
the synthesizer is actually connected to. If it isn’t, pull down the Output 
menu for that Track and select the desired MIDI Output.
If you only have one standard MIDI interface, that is limited to 16 MIDI Chan-
nels, then this setting is probably correct as it is. If you for example have a 
standard MPU compatible interface installed, this should say something with 
“MPU-401”.

Clicking in the Output column 
brings up a pop-up which lists 
the available MIDI Outputs 
plus an item called MROS.
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Selecting a sound for the Recording

The next step is to make sure the instrument plays the desired sound on the MIDI 
Channel you have chosen for this recording. There are two ways to do this:

Using the Instrument’s front panel

Normally you can select sounds (“Programs”, “Presets”, “Patches”, “Tones”, 
“Voices” or whatever they might be called) – for each MIDI Channel – directly 
from the front panel on the instrument. If you choose this method, please refer to 
the instrument’s operation manual for details.

Using the Inspector

You can also select sounds directly in Cubase.

● Your instrument must be set up to receive MIDI “Program Change” messages 
for this to work.
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1. Click on the Inspector icon, below the Track list.
The Inspector appears.

2. Click in some empty part of the Part Display (the area to the right of the 
Track list).
This is to make sure no Part is selected.

...opens the Inspector to the left of the Track 

Clicking on the icon in the lower left 
corner of the Arrange window...
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3. Select the desired Track by clicking on its name.
The top text in the Inspector now says ”Trackinfo” and below this the name of 
your Track is displayed. This is your verification to that the Inspector actually 
shows the settings for the right Track (the selected one).

4. Use the field titled Program (the area next to the characters “Prg” in the 
Inspector) to set the correct Program number.
In MIDI, Programs are always numbered continuously, and in Cubase they are 
numbered from 1 and up. Your instrument might use some other numbering 
scheme, so you might need to experiment a bit before you get the right sound.

Changing this setting 
sends out MIDI 
Program Change 
numbers.
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Verifying the Settings

Now when you play your keyboard you should hear the right sound in the synthe-
sizer (and only that sound). If not, check the following:

• Is the Track set to the same channel as the MIDI instrument?
• Is the Track set to the right MIDI Output?
• Do you have MIDI Thru enabled in Cubase?
• Do you have Local Off activated in your instrument (if needed and/or availa-

ble)?
• Do you have the correct sound selected in the synthesizer?
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Click

Recording into a sequencer is normally done in time with a metronome click. So, to 
make sure you hear the metronome, check that the Click button is activated. If it 
isn’t, click on it.

This activates a click directly from the computer. If you want a MIDI metronome, 
check the Metronome dialog (reached from the Options menu).

Tempo and Time Signature

To set a Tempo and Time Signature for your recording, proceed as follows:

1. Make sure the Master button on the Transport Bar is turned off.
You need to activate the Master (Track) if you want tempo changes in your 
song. Otherwise it is best turned off.

Click activated on 
the Transport bar.
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2. Set a Tempo and a Time Signature of your choice in the boxes above the 
Master button on the Transport Bar.
You can change each of the two Time Signature values separately to get time 
Signatures from 1/2 to 16/16.

Other settings on the Transport Bar

If you are recording into the default Arrangement, the settings on the Transport Bar 
are probably perfectly OK. If not, make sure things are set as indicated in the pic-
ture below:

Tempo

Time Signatur

The Master button
turned off
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So now you’re done with all preparations! Let’s record!

All these three buttons 
should be turned off

This setting is of 
no relevance 
right now

Leave this like 
this for now

This setting is of no 
relevance right now

This is used to set the start 
point (1.1.0 = beginning 
of the Song)

Leave this turned 
off for now

Leave this 
turned off for 
now
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Activating recording from Stop Mode
This section teaches you how to record from stop mode. Later you will learn other 
techniques, like Punch In and Out and Cycled Recording.

Specifying a start point for the Recording

Recording starts from the position of the Left Locator. This is a marker, visible as a 
line stretching over the Arrangement and with an “L” flag in the ruler.

There are a number of ways to set the Left Locator described on page 109. For now, 
let’s introduce three ways:

• You can click in the Ruler with the left mouse button.

• You can drag the Left Locator flag in the Ruler.

• You can change the Left Locator position on the Transport Bar.

When you begin recording on a new song, you probably want the Left Locator po-
sitioned at the beginning of the song (1.1.0) as indicated in the previous picture.

The Left Locator flag The ruler
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Recording

1. Click on the Record button or press [*] on the numeric key pad.

2. Wait until the two-bar count-in is finished.
You can change the length of the count-in in the Metronome dialog box later, 
should you wish.

3. Start playing your keyboard.
You can play as much as you want to for as long as you want.

4. When you are done, click the Stop button.

Now, a box appears on the Track. This is called a Part, and is a container for your 
MIDI notes.

Clicking the Record button

Clicking the Stop button
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Rewinding

As you recorded, a line moved across the Arrange window indicating the current 
position. This line is called the Song Pointer. The position is also indicated on the 
Transport Bar. To hear what you just recorded, you must first rewind the Song Po-
sition to the Start:

Using the Rewind button

One way of moving the Song Position is to click on the Rewind button for as long 
as is needed.

Clicking the Rewind button.

A newly created Part
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Using the Stop button

Another, quicker way of rewinding is to click the Stop button again (or to press 
[space bar] or [0] on the numeric key pad). This moves the Song Position to the Left 
Locator. If the Left Locator isn’t at the beginning of the Song, simply click Stop 
again and the Song Pointer is moved to the absolute beginning of the Song.

Clicking the Stop button.

Listening to the Recording

Now all you have to do to hear what you recorded, is to click the Play button or 
press [Enter] on the numeric key pad.

Activating Play.
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Redoing the Recording

In case you realise you didn’t really like what you just did, you can try either of the 
two following methods:

Using Undo

If you haven’t made any changes to the Arrangement since you recorded, you can 
simply Undo the recording by selecting Undo from the Edit menu. Remember you 
can only Undo your last action.

Deleting a Part

You can delete a recording (a Part) by clicking on it and selecting Delete from the 
Edit menu or by pressing [Backspace].
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Recording more on the same Track

If you wish to record more on the same Track, proceed as follows:

1. Move the Left Locator to the position you want to start recording from.
Move the Left Locator by dragging the “L” flag in the ruler, by clicking in the 
ruler with the left mouse button or by changing the value in the Left Locator 
box on the Transport Bar.

2. Make sure the Right Locator is to the right of the Left Locator. If it isn’t, 
please move it.
Move the Right Locator by dragging the “R” flag in the ruler, by clicking in the 
ruler with the right mouse button or by changing the value in the Right Loca-
tor box on the Transport Bar.

● You can not activate recording if the Locators are positioned in “reverse or-
der”.

3. Activate Recording.

The Right Locator must be 
positioned to the right of the Left 
Locator.
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You will hear a count-in just as you did the first time, and then recording starts from 
the Left Locator position.

When you have finished recording, you will probably get a new Part, just after the 
first one.

The second Part appears after the first.

There are other methods for recording more on the Track, described under the 
terms “Punch In” and “Preroll”, later in this book.

Recording the next Track

To record on the next Track, proceed as follows:

1. Select an existing empty Track, or create a new one.

2. Set up the Track and the synthesizer so that you have a different MIDI 
Channel for this recording.
Again, the MIDI Channel on the Track and in the instrument must correspond.
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3. Select a sound for this recording, just as with the first.
Again, this can be done either on the front panel of the instrument or from the 
Inspector, it all depends on your instruments and which method you prefer.

4. Set the Left Locator and activate recording as on the first Track.

Now, if you have everything set up OK, you should hear your first Track while you 
record the second.
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Overdub or Replace? – That’s the question...
On the Transport Bar, you will find a button called Record Mode. when you click 
on it, it switches between Overdub and Replace.

The Record Mode button.

Overdub

Up until now, we have assumed that this switch was in Overdub mode. When you 
record on a Track in Overdub mode, whatever you play is added to what was previ-
ously on the Track. This is unlike a regular tape recorder where as soon as you start 
recording, what was previously on the tape gets erased.

Overdub Mode is probably the safest way to record. If you add too much music, 
you can simply remove it later by editing (see the chapter “An Introduction to MIDI 
Editing”).

Record some notes...

Whenever you record again on 
the Track, the new notes are 
simply added to the existing ones
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Replace

In this mode, whatever you record replaces what was previously on the Track. Re-
place mode is probably the best choice if you have made a mistake and wish to cor-
rect it by recording something new.

Record some notes...

When you record again on the 
Track, the new notes replace 
the existing
- 60 - 



Setting Precount and using Preroll and Prerecord
In the Metronome dialog box you have three options related to what happens when 
you activate recording:

Precount

• By enabling/disabling the Precount you can decide if you want a count-in at 
all when you activate recording.

• By changing the Bars value you can set how long you want the Precount to 
be.
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• If you disable the “From Mastertrack” function you can change the Time Sig-
nature for the count-in.

Prerecord

If this function is activated, Cubase will record during the Precount (count-in). 
Even if you don’t hear your other Tracks during the Precount, you can for example 
add a note at the upbeat, just before playback starts.

● You can not record before song position 1.1.0 (the beginning of the song).

Preroll

When this is activated, the Precount (count-in) is not silent, instead you will hear 
the last bar(s) before the Left Locator. How many bars you hear depends on the 
Bars setting described above.
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If you use the Preroll feature, you might probably want Prerecord activated at the 
same time, so that you can record during the Preroll.

Other options in this dialog box

The remaining options in this dialog are for setting up how the metronome should 
sound.

When you activate 
recording from the Left 
Locator, with Preroll 
activated...

... the Song Position 
jumps back a number of 
bars and recording is 
activated.
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Recording different types of MIDI Messages
There are a few facts about the recording of some types of MIDI messages that can 
be useful to know. If you don’t know too much about MIDI you may not under-
stand everything below. Later when you have gained a more thorough understand-
ing, come back and read this information.

Filters

You can prevent Cubase from recording certain types of MIDI data, see the chapter 
“Filtering and Mapping MIDI Data”.

Notes

In MIDI, when you press and release a key on your synth or other MIDI keyboard, 
a Note On (key down) and a Note Off (key up) message are sent out.

The MIDI note message also contains the information which MIDI Channel was 
used.When Cubase records a note it also stores its MIDI Channel number.

Normally you set the playback MIDI Channel in the Track List, and this setting 
overrides the channel stored with the notes (and other Events). 
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In fact, this goes for all MIDI messages that are coming in on a certain Channel (all 
Channel Voice and Channel Mode messages). This can be used as a feature in com-
bination with Cubase’s MIDI Channel setting “Any”. A more thorough explanation 
is found in the chapter “MIDI Input, Output and MIDI Channels”.

Continuous Messages

Pitch bend, AfterTouch and Controllers (like modulation wheel, sustain pedal, vol-
ume etc.) are considered as MIDI continuous Events (as opposed to the momentary 
key down and key up messages).

About recording Continuous Messages

If you move the Pitch Bend wheel on your synthesizer while recording, this move-
ment gets recorded together with the key (Note On and Note Off messages), just as 
you’d expect.

But the continuous messages can also be recorded after the notes have been re-
corded (or even before). They can also be recorded on Tracks separate from the 
notes they belong to. 
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Say for instance that you record one or several bass Parts on Track 2. If you now set 
another Track, like Track 55, to the same Output and MIDI Channel as Track 2 you 
can make a separate recording of just Pitch Bends for the bass Parts. This means 
that you activate recording as usual and only move the Pitch Bend wheel during the 
take. As long as the two Tracks are set to the same Output and MIDI Channel it will 
appear as if the two recordings were made at the same time.

A word of warning

You can run into problems with Controllers that don't match up. If you for instance 
deactivate recording (punch out) with the sustain pedal on your synthesizer down, 
you have instructed the program to keep the notes hanging, since the release of the 
pedal has not been recorded.

The same applies if you leave the Pitch Bend wheel or the modulation wheel up (or 
any other MIDI Controller for that matter), when you stop recording. During play-
back, Cubase may clean up Pitch Bend, Modulation and Damper pedal and Chan-
nel Pressure at the end of each Part, taking into account what happened in earlier 
Parts. But, the way Continuous MIDI messages behave is still something to be 
aware of.
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Program Change Messages

Normally, when you switch from one Program to another on your keyboard (or 
whatever you use to record), a number corresponding to that Program is sent out via 
MIDI as a Program Change message. These can be recorded on the fly with the mu-
sic, recorded afterwards on a separate Track, or manually entered in one of the Edit 
windows. You can also enter Program Change messages in the Inspector. 

System Exclusive Messages

System Exclusive is a special type of MIDI message used to send things that only 
make sense to a unit of a certain make and type. Every major MIDI manufacturer 
has its own Sys Ex identity code. Sys Ex can be used to transmit a list of the num-
bers that make up the settings of one or more sounds in a synth. System Exclusive 
can be recorded just as any other messages and can be edited in List Edit.

System Exclusive messages are discussed in more detail in the chapter “System Ex-
clusive Handling”.

● Please remember that there is nothing that prevents you from Cycled record-
ing (see page 80) of Sys Ex data, although this can lead to serious confusion. 
In plain English: don’t, if you’re not absolutely sure of what you are doing.
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Punch In and Out 4
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What is Punch In and Out?
Those of you who have used multi-track tape recorders know about a technique 
called Punching In. This is when you activate recording while the tape is rolling. If 
you for example have made a mistake in the middle of a chorus, you can play back 
from the beginning of the chorus and just before the flawed section, punch in and 
replace that section with a new performance.

Punch Out is when you deactivate recording without stopping playback. If – in the 
example above – the chorus is followed by a verse which is perfectly OK, you 
would punch out at the end of the chorus so that you don’t record anything on the 
verse.

In Cubase there are two ways to Punch In and Out: Manual and Automatic:

Automatic Punch In
1. Select a Track and set it up as necessary (as with any other recording).

2. Decide if the new recording should replace what is currently on the 
Track or if you want to add to it.
This is done with the Record Mode switch (Replace/Overdub) as described in 
the previous chapter.
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3. Set the Left Locator at the position where you want recording to be acti-
vated.
As described above, two ways of doing this are by dragging the “L” flag in the 
ruler or by changing the value in the Left Locator box on the Transport Bar.

4. Move the Song Position to some point before the Left Locator.
Again this can for example be done by using the Transport buttons (Rewind, 
Fast Forward etc) or by changing the value in the Song Position box. More 
info on page 101.

5. Click on the Punch In button on the Transport Bar so that it is activated.

6. Activate playback.

Punch In activated.
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Now, when the Song Position reaches the Left Locator, recording is automatically 
activated, as you can note by observing the Record button on the Transport Bar.

7. Record.

8. Terminate recording either by stopping or by Punching Out (see below).

3. When the 
program reaches 
the punch in 
point...

1. Set the Song 
Position...

2. Activate 
playback...

4. Recording is 
automatically 
activated!
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Manual Punch In
1. Select a Track and set it up as necessary (as with any other recording).

2. Decide if the new recording should replace what is currently on the 
Track or if you want to add to it.
This is done with the Record Mode switch (Replace/Overdub) as described on 
page 59.

3. Make sure Automatic Punch In on the Transport bar is not activated.

4. Move the Song Position to some point before the position where you 
want to Punch In.
Again this can for example be done just by using the Transport buttons (Re-
wind, Fast Forward etc) or by changing the value in the Song Position box.

5. Activate playback.

Punch In deactivated.
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6. When you reach the right position, click on the Record button or press 
[*] on the numeric key pad.

7. Record.

8. Terminate recording either by stopping or by Punching Out (see below).

About punching in on long notes

When you activate recording in Cubase, already recorded notes are never cut off, 
they will play to their end just as they did before you started this recording. This is 
true regardless of the Record mode chosen (Overdub or Replace).

About punching in on Controller or Pitch Bend data

Watch out when punching in on recordings with Pitch Bend or Controller data 
(modulation wheel, sustain pedal, volume etc), since this may lead to strange ef-
fects (hanging notes, constant vibrato etc). See page 65.
- 73 - 



Automatic Punch Out
1. Set the Right Locator to the position where you want recording to be ter-

minated.
Either drag the “R” flag in the ruler or change the value in the Right Locator 
box on the Transport Bar.

2. Click on the Punch Out button on the Transport Bar so that it is acti-
vated.

The Right Locator 
positioned

Punch Out 
activated
- 74 - 



3. Now, recording is automatically deactivated when the Song Position 
reaches the Right Locator.

You can of course combine automatic Punch In and Out for a totally automated re-
cording.

Activate recording.

When the Song 
Position reaches the 
Right Locator...

Recording is 
automatically 
deactivated, but 
playback continues.
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Manual Punch Out
1. Activate recording in any way you like.

You might for example combine manual Punch In and Out to fix an error in 
an otherwise good performance.

2. When you reach the right position, click on the Record button or press 
[*] on the numeric key pad.

3. If you like, Punch in again and record some more.

4. When you’re done, Stop Cubase.
- 76 - 



5

Cycled Playback and Recording 5
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What can I do with the Cycle?
Cubase can play back and record in a Cycle – a loop. You decide where the Cycle 
starts and ends by setting the Left and Right Locators. When Cycle is active you 
can repeatedly listen to a section of the Arrangement, and record, adding more on 
each lap etc. Cycled playback is also convenient when editing and when making 
adjustments in the Inspector.

Setting up the Cycle
1. Set the Left Locator to the position where you want the Cycle to begin.

2. Set the Right Locator to the position where you want the Cycle to end.

3. Click on the Cycle button so that it gets activated, or press [÷]on the nu-
meric key pad.

Set up the Left and 
Right Locator...

...and activate the 
Cycle
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Playing back the Cycle
When you play back with Cycle activated, the section between the Locators gets re-
peated indefinitely.

You can use all and any functions while the program is playing back. This fact al-
lows you to use Cycled playback for a number of things, many of which you will 
learn about later in this manual:

• Rehearse a part before recording.
• Mute Tracks and Parts to try out variations on an Arrangement.
• Concentrate editing in the MIDI editors to a certain section of the Song.
• Make adjustments in the Inspector, apply Quantizing etc, to fine tune levels 

and grooves.
• Make adjustments to the sounds in your instruments or try out a Track with 

another sound.
• etc, etc.
- 79 - 



Recording in Cycle Mode

From the Left Locator

1. Set up the Cycle and activate the Cycle button.

2. Set up a Track to record on.

3. Use the Record mode switch on the Transport Bar to decide if you want 
the stuff you record to be added to what was previously on the Track or 
if you want it to replace the existing recording.
This is described on page 75.

4. Click the Record button.

5. After the count-in, start playing.

6. Keep playing on each lap of the Cycle until you are satisfied.
See the Cycled Recording Modes and Functions described below.

7. Stop Cubase or punch out manually.

Cycle On/Off
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From Before the Cycle

1. Set up the Cycle and activate the Cycle button.

2. Set up a Track to record on.

3. Use the Record mode switch on the Transport Bar to decide if you want 
the stuff you record to be added to what was previously on the Track or 
if you want it to replace the existing recording.
This is described on page 75.

4. Activate automatic Punch In on the Transport Bar.

5. Set the Song Position to some point before the Cycle.

6. Activate playback.

When Cubase reaches the Cycle, recording is automatically activated.

7. Keep playing on each lap of the Cycle until you are satisfied.
See the Cycled Recording Modes and Functions described below.

Punch In activated.
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8. Stop Cubase or punch out manually.

● If you Punch In manually before the Cycle, the Cycle is automatically turned 
off!
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Punching In and Out in the Cycle
Once you are in the Cycle you can punch in and out manually as many times as you 
wish without stopping in between. Simply click the Record button or press [*].

Switching Tracks while recording
You can record on more than one Track while in the Cycle:

1. Set up a few Tracks that you wish to record on. Also set up the instru-
ment(s) so that they play the right sounds on these MIDI Channels.

A few Tracks set up for recording a four bar groove.

2. Enter recording in Cycle mode.
Record on the first Track.

3. Without stopping, select a new Track in the Track list or use the [↑ ] and 
[↓ ] keys to step through the Tracks.
Selecting a new Track set to a different MIDI Channel and maybe Output, au-
tomatically routes your playing to the new sound.
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4. Record on this second Track as with the first.

5. Keep recording on different Tracks until you are satisfied.
See the Cycled Recording Modes and Functions described below.

6. Stop Cubase or punch out manually.
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Cycled Recording Modes

Switching Modes

On the Transport Bar you will find a small box labelled “Cycle Rec”. This is used to 
select one of three “behaviours” when recording in Cycle Mode.

You can select any of the modes prior to, or during, recording.

The Cycle Rec Mode Switch
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Mix Mode

In Mix mode, everything you record is added to what was recorded before. This is 
the preferred mode if you for example are building up a rhythm pattern in Cycle 
mode. You can start with the hi-hat, add bass drum on the second lap, snare on the 
third etc.

Punch Mode

In this mode Cubase automatically punches in the moment you play anything on a 
lap. Proceed as follows:

1. Select Punch Mode.

2. Start Recording in a Cycle.

Record some notes on the first 
lap...

Whatever you record on the 
following lap(s) is simply 
added to the existing notes
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3. If you make a mistake in the middle of the Cycle, simply wait until you 
reach the correct position on the next lap, and start playing again.
What was previously recorded from this point to the end of the Cycle is re-
placed with what you play now.

4. When you have a recording you’re happy with, you can turn off Punch 
mode, Stop or Punch Out.

Normal Mode

The name Normal mode refers to the way Cubase behaves during normal (as op-
posed to Cycled) recording. This allows you to record afresh on the Track each time 
you enter the Cycle.

1. Decide if you want to overwrite earlier recordings on the Track or not, 
by selecting a Record Mode (Overdub or Replace).
See page 75.

Record some notes on the first 
lap...

Whenever you start playing on an 
upcoming lap, your new 
recording will replace the notes 
from that point and onwards.
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2. Select Normal Cycled Recording Mode.

3. Record something on a lap.
You will not hear what you recorded, on the next lap(s).

4. If you’d like to redo the recording, simply try again on any upcoming lap.
Everything you recorded on earlier laps is automatically deleted.

5. When you have a performance you like (a complete recording on a lap), 
stop recording or switch to another Cycled Recording Mode.

● Please note: a complete lap is only kept when the recording is stopped some 
time during the next lap.

Record some notes on the 
first lap...

If you play anything on any of 
the upcoming laps, it will 
totally replace your earlier 
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Cycled Recording Functions
These functions are found on a pop-up menu that appears when you press the 
mouse button with the pointer over the “Cycle Rec” text on the Transport bar, while 
recording in Cycle mode.

Delete Last Version

If you just made a mistake on the last lap, proceed as follows:

• While recording, select Delete Last Version from the pop-up menu or 
press [V] on the computer keyboard. 

This erases your last recording. It doesn't matter if you didn't play anything for sev-
eral laps, the last lap that you recorded anything on is erased.
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Delete Subtrack

If you make a mistake and don't wish to keep anything of what you've just recorded, 
proceed as follows:

• While recording, select Delete Subtrack or press [B] on the computer 
keyboard.

The Part is cleared (but not deleted) and you can instantly start inputting music 
again, without leaving Record mode.

Key Erase

To erase all notes played with a certain key, or keys, proceed as follows:

1. While recording, press and hold the relevant keys on the synth keyboard.

2. Select Key Erase from the pop-up menu or hold down [K] on the compu-
ter keyboard.

Quantize Last Version

Quantizing is a function you can use to let the computer correct imprecisely played 
notes to the next correct timing position, defined by you. Quantizing is not irrevo-
cable, it can always be undone unless you specifically “freeze” your Quantize. Cu-
base provides several different Quantize options, described on page 224.
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If you want to over Over-Quantize everything you recorded on the last lap, proceed 
as follows:

1. Select a Quantize note value by using the Quantize pop-up at the top of 
the Arrange window.

2. Select Quantize Last Version or press [N] on the computer keyboard. 

Just as with Delete Last Version, it doesn't matter if Cubase has played back the Cy-
cle several times since you last played anything, the last lap you recorded anything 
on is Quantized anyway.

The Quantize pop-up
- 91 - 



About the Cycle and the Overdub/Replace Switch
As described on page 75, the Overdub/Replace switch is used to decide if what you 
record now is added to whatever was on the Track before or whether it should re-
place the existing recordings.

The same is true for Cycled Recording:

• If Overdub is selected, everything you record is added to what was previously 
on the Track.

• If you select Replace mode, everything you record during one recording pass 
(the time from which you activate recording until you deactivate it again) re-
places what was previously on the Track.
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• The Cycle recording Modes and Functions described on the previous pages 
only apply to what is recorded during one recording pass. For example, the 
special Cycle Punch Mode does not delete any notes recorded on the Track 
before, only notes that were recorded in the Cycle this time.

1. Let’s say you have a Part 
already recorded.

2. You activate Cycled 
recording in Overdub Mode to 
add more notes.

3. If you now use the Cycle 
Mode Punch function, you 
will only replace the notes 
recorded during the Cycle 
recording pass.
The previously recorded 
notes are not affected.
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Playback, Tempo and the Transport 
Bar 6
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The Transport Bar
Below, you will find a brief description of what each control on the Transport Bar is 
used for:

Activates Punch In

Switches between 
the three modes for 
Cycled Recording

This setting determines whether 
what you now record is being 
added to (Overdub), or replaces 
(Replace) what has previously 
been recorded on a Track

Punch Out point 
and end of Cycle

Record start point, Punch In 
point and beginning of Cycle.

Cycle On/Off

Activates 
Punch Out

Handle 
(move)
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Song Position 
(Meter format)

Song Position 
(Time format)

Position Slider

Rewind Fast Forward Stop Play Record

Indicates MIDI 
In/Out activity

Activates synchronization 
to other equipment

TempoTime SignatureTurns the Metronome 
On/Off

Turns the Master 
Track On/Off

Activates automatic 
quantization during record
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Hiding and showing the Transport Bar

To hide the Transport Bar,  select “Hide Transport” on the Windows menu. To bring 
it back, select “Show Transport” from the Windows menu.

When the Transport Bar is hidden, you can still access all its functions via the com-
puter keyboard. See below for a list of Transport Bar commands.

Moving the Transport Bar

You can put the Transport Bar anywhere you want it, by dragging the handles.
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The Numeric Key Pad
The numeric part of the computer keyboard is used for many Transport Bar opera-
tions. Some of these are described in more detail later in this chapter.

In addtion to this, the Page Up and Page Down keys function as Fast Forward and 
Rewind.

Num
Lock ÷ x –

7 8 9

4 5 6 +

1 2 3

0 , Enter

Record

Lower Tempo

Raise Tempo

Play

Cycle On/Off

Go to 

Go to 

Go To 

Go To 

Cue Point

last Stop

Left Locator

Right Locator

Stop
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If you have a computer without a numeric key pad, some transport commands are 
still available from the regular keyboard (the picture shows American key caps):

The Space bar also functions as Stop button.

9 0 – =8

[ ]Cycle On/Off PlayRecord
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Basic Tempo and Time Signature Handling

Transport Bar and Master Track Tempo

There are actually two sources for Cubase’s tempo:

• When the song uses a steady tempo throughout, you can have the Master but-
ton on the Transport Bar turned off and simply set the right tempo directly on 
the Transport Bar. The tempo can be adjusted at any time, even while playing 
back.

• When the song contains tempo changes, you need to use the Master Track, 
(which is Cubase’s tempo Track but also more! See the chapter “The Master 
Track”). For those tempo changes to actually “happen” on playback, the Mas-
ter button on the Transport Bar must be activated. This is all discussed in the 
chapter “The Master Track”.

The Tempo setting on 
the Transport Bar is 
used.

The Tempi set on 
the Master Track 
are used.
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Setting the Transport Bar Tempo

The tempo on the Transport Bar is adjusted like any other value (see page 14 in this 
book). The value is in BPM (Beats Per Minute). The integer and fraction part can 
be adjusted separately, if needed.

Setting the Song and Time Position

Using Fast Forward and Rewind

The Song Position can of course be moved using Fast Forward or Rewind. If you 
hold down [Shift] while clicking the button, Rewind/FF is much faster.

Rewind Fast Forward
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By double clicking in the Ruler

If you double click somewhere in the ruler, the Song Position Pointer is moved 
there.

By using the Position Slider

The position slider is located on the Transport Bar. You can drag the handle or click 
directly somewhere on the line to move the handle there.

The throw of the slider is relative to the length of your song. This means that if you 
drag the slider all the way to the right, the Song Position will appear at the end of 
the last Part.

Dragging the Position Slider.

Double-click in the ruler... ...to move the Song Position Pointer.
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About the Snap Value

When you change the Song Position in the ruler or by using the position slider, 
something called “the Snap value” helps you find exact positions quickly. It does 
this by limiting the possible points for positioning, to Bar, half note, quarter note, 
etc. Snap can of course also be set to Off.

The Snap value is set with the Snap pop-up at the top of the Arrange window.

The Snap pop-up.

Value Description

Off Any position can be used

Bar Movement is restricted to exact bar lines.

1/4 to 1/16 Movement is restricted to the selected note value.
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Changing Position values on the Transport Bar

You can adjust the Meter or Time Position values on the Transport Bar, as described 
in the chapter “Basic Methods”. The Song pointer is moved accordingly.

If Snap is set to Bar...

...the Song Position can only be 
dragged to exact bar lines.

If Snap is set to for example 1/4...

...the Song Position can be put 
on any quarter note position.
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Making relative Position changes

If you double click on either position value and enter a new one, preceded by a “+” 
or “–” character, the song position is moved relatively.

Double click...

...enter a value 
preceded by + or –...

...and the value 
gets added to the 
existing position
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Returning to the beginning of the Song

If the Song is stopped and you click the Stop button again (or press [0] on the nu-
merical key pad), the following happens:

• The Song Position is moved to the Left Locator.
• If the Song Position is already at the Left Locator or to the left of it, the Song 

Position is moved to the beginning of the Song.

This means that you can always click twice on the Stop button to return to the be-
ginning of the Song.

Going to the left side of the window

If you press the [Home] key on the computer keyboard, the Song Position pointer is 
moved to the left side of the window.

Going to the last Stop Position

If you press [9] on the numeric key pad, the Song Position moves to the place you 
last stopped at.
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Moving to the Locators

• If you press [1] on the numeric key pad, the Song Position is moved to the Left 
Locator.

• If you press [2] on the numeric key pad, it is moved to the Right Locator.

Using Cue Points

Cue points are used to quickly locate to any position. If you for example often find 
yourself jumping to the beginning of the first chorus, set up that position as a cue 
point.

Programming Cue Points

1. Set the Song Position to where you want the Cue Point to be.

2. Hold down the [Shift] key and press any of the keys [3] to [8] on the nu-
meric key pad.
The key is now programmed with that position.

Locating to Cue Points

If you press any of the keys [3] to [8] on the numeric key pad, the Song Position is 
moved to the position programmed for that key.
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Cueing
Cueing is when you fast forward through the music while playing it. You might 
have done this on a multi-track tape recorder. The big difference with Cueing in 
Cubase is that the music is played back with normal pitch.

1. Click and hold down the right mouse button with the pointer over the 
Fast Forward button.

or...

1. Hold down the  [Control] key.

2. Click and hold down the left mouse button with the pointer over the Fast 
Forward button.

• To change the speed of cueing, drag the mouse left/right.
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Locators

Setting the Locators by dragging in the Ruler

1. Set the Snap value.
The Snap value restricts the positions you can move the Locator to, as with 
the Song position, see page 103.

The Snap pop-up.

2. Point at the left or right Locator flag in the ruler, and press the corre-
sponding mouse button (left or right).
You may actually point anywhere in the ruler; the Locator flag will move to 
the pointer when you press the mouse button.
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3. Drag left or right.

Dragging the Left Locator

4. Release the mouse button.

Setting the Locators by clicking in the Ruler

1. Set the Snap value.
See above.

2. Click somewhere in the ruler with the left mouse button, to move the Left 
Locator.
The Locator appears at that position. To move the Right Locator, click with the 
right mouse button.

Click with the left 
mouse button...

...to position the 
Left Locator.
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Setting the Locators on the Transport Bar

You can also adjust the Left and Right Locator position by changing the numerical 
values in the Locator boxes on the Transport Bar.

Making relative Position changes

Just as with positions (see page 105 in this book) you can double click and enter a 
new value, preceded by a “+” or “–” character. When you hit [Return] the Locator 
is moved relatively.

Setting the Locators by selecting Parts

You can adjust the Locator positions to the range of the currently selected Part(s).

1. Select the Part(s) by clicking on it/them.
If the range includes several Parts, hold down the [Shift] key while selecting.
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2. Hold down the [Alt Gr] key and press [P].

Pre-programming Locator Pairs

If you find yourself moving the Locators back and forth between the same positions 
all the time, you can pre-program some Locator combinations for instant recall:

1. Set up the Locators as desired.

2. Hold down the [Shift] key on the computer keyboard.

3. Press one of the Function keys [F2] to [F11] on the computer keyboard.
That key is now programmed with the current settings of the Locators.

Select one or more Parts, press [Alt Gr]-[P]...

...and the Locators are moved to the edges of the “block”.
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Recalling Locator Positions

• Press the desired function key ([F2] to [F11]).
The Locators are moved to the memorized positions.
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Using Time Positions in the Rulers
If you’d like to use Cubase as a time based program, rather than a meter (tempo) 
based one, you can change the position indicators in any window, as follows:

1. Locate the Mouse Position box.
In the Arrange window this is located on the Status Bar (the area directly 
above the ruler).

2. Click once in the box.
Now the ruler and the Mouse Position box change to show time positions in-
stead of meter positions.

Positions in Meter format
Positions in Time format

The Mouse Position box
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3. To switch back to meter positions, click again.

● Please note that even though you have switched to time positions, Snap is still 
on and relates to meter positions. You might want to set Snap to “Off” when 
using time positions.
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7

Managing Tracks 7
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What can I do with Tracks?
The Track is one of the most basic concepts in Cubase. Every time you record 
something in Cubase, the recorded material is placed on a Track. You can have 
thousands of Tracks in each Arrange window, and you can easily move or copy ma-
terial between Tracks (if the Tracks are of the same kind - see Track Classes, page 
127).

The most obvious reason for putting the recorded material on different Tracks, is 
perhaps that you want to have your music played back by different “instruments” - 
or maybe rather by different sounds on a MIDI Sound Module or Keyboard. But 
there are also many other advantages of working with many Tracks.
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Creating Tracks
Create a new Track when you want to add another “layer” to your recording. You 
might for example want to add another “instrument”, or make room for an alternate 
version of a part in your music. There are several ways to create a new Track:

By using the Mouse

Double clicking in an empty 
part of the Track List... ...creates a new Track.
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By using the Structure Menu

Selecting Create Track from the Structure menu will make a new Track appear at 
the bottom of the Track List. You may also use the keyboard short-cut [Control]-[T] 
to accomplish the same thing.

What name will the new Track have?

If you start with an empty Arrange Window (with no Tracks), and create a new 
Track, it gets the name “Track 1”. Next time you create a New Track, this gets the 
name “Track 2” and so on. You can rename a Track at any time (see Naming 
Tracks, below).

Naming Tracks
You can rename a Track, simply by double clicking on its current name in the Track 
List, and typing in a new name.
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Selecting Tracks
If you want to record on a Track, change settings for it or perform an operation that 
affects a whole Track, the Track has to be selected for Cubase to “understand” 
which Track you wish to direct the action to.

By clicking

1. Click in the name field of the Track you want to select.

2. The Track gets inverted (white on black).
The Track you have selected is called the “active Track” or the “selected 
Track”.

This Track is selected.
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By using the keyboard

You may also simply “move” the selection up or down in the Track List by using 
the [↑ ] and [↓ ] keys on the computer keyboard. This will select the Track above/be-
low the currently selected.

Finally, you may also press [Alt Gr]-[T] on the computer keyboard, and type in the 
number of the Track you want to select (counted from the top of the Track List).

If you press the [↑ ] key...

...the Track above in the 
Track List gets selected.
- 121 - 



Changing the order of the Tracks
You can rearrange the Tracks in the list like this:

1. Press the mouse button with the pointer on the Track you 
want to move. The pointer takes on the shape of a hand.

2. Drag the Track with the mouse button pressed. A dotted 
outline shows you where the Track will be placed.
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● All the Parts on the Track are moved with the Track.

3. When you release the mouse button, the Track is 
moved to its new position.
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Duplicating Tracks
You may make a copy of a Track and all Parts on it. 

1. Position the pointer on the name of the Track in the Track List.

2. Hold down [Alternate] on the computer keyboard and press the mouse 
button.

3. Drag the outline of the Track to an empty  field in the Track List.
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4. Release the mouse button.

● You can not duplicate empty Tracks.

A duplicate of the selected Track is created and placed, 
complete with Parts, at the bottom of the Track List.
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Deleting Tracks
You may delete a Track and all Parts on it.

1. Make sure that no Part is selected (inverted).
This is to make sure that what you Delete will be a Track, not a Part. 

2. Press [Backspace] on the computer keyboard or select Delete Track on 
the Edit menu.

● If you change your mind, you can undo the Delete Track operation with the 
Undo option on the Edit menu, or by pressing [Control]-[Z] on the computer 
keyboard.

Check that this menu item says 
“Delete Track”, not Delete Parts.
- 126 - 



Track Classes
There are different types of Tracks, called classes. In the column marked “C” in the 
Track List, a small symbol shows which class each Track has. 

How to select a Class for a Track

Press the mouse button 
with the pointer in the 
“C” column for a Track...

...to pull down a menu 
where you can select a 
Track Class.
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Converting a Track from one Class to another

If you have not recorded anything yet on a Track, you may at any time convert it to 
any class. Just select the new class from the menu as described above. If there is 
something recorded on it you may not be able to select another class for the Track.

● In the rest of this manual, if nothing else is stated, an operation applies to all 
Track classes.

The seven basic Track Classes

MIDI Tracks

MIDI Tracks are the most common type. They are used for regular MIDI recording 
and editing.
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Drum Tracks

Just like MIDI Tracks, Drum Tracks contain MIDI Events, but Drum Tracks are tai-
lor-made for use with the Drum editor. This Cubase feature makes editing rhythmic 
Tracks much easier, keeping track of exactly which key is assigned to which drum 
sound etc. You can convert a MIDI Track to a Drum Track and vice versa, at any 
time. See the chapter “Drum Edit”.

Mix Tracks

Cubase features a MIDI Mixer, a window that lets you control the volumes, settings 
and parameters on your connected sound modules and other devices, from inside 
the program. A Mix Track contains information about the MIDI Mixer actions, 
rather than regular MIDI Events.The MIDI Mixer is explained in more detail in the 
chapter “The MIDI Mixer and Mix Tracks”.

Group Tracks

Cubase lets you put together different parts of the recorded material into Groups. 
You may for example Group all of the instruments in the verse, bridge or chorus of 
a song, and thereby get different building blocks to use when you are rearranging 
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your song. The Group Track will not contain regular MIDI data, but instead just 
these building blocks or Groups. By moving and copying Groups on the Group 
Track you can easily try out new arrangements.

Groups are explained in more detail in the chapter “Groups”.

Tape Tracks

Tape Tracks are used to control Tape Recorders from Cubase. This is explained in 
detail in the chapter “Tape Tracks – Controlling Tape Recorders”.

Style Tracks

Cubase Score and Cubase Audio  come with a module that lets you work with 
“Styles”, a kind of automated accompaniment patterns. If the module is activated 
(see the Modules chapter in the Getting into the Details book), the Style Track 
Class symbol appears on the pop-up menu. Style Tracks contain information about 
which Style the accompaniment should use. See the Style Tracks chapter.
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Chord Tracks

Chord Tracks contain information about chord changes. These chords are used by 
the Style Tracks, and in the Score editor in Cubase Score and Cubase Audio.

Other Classes

If you purchase an expanded version of Cubase, more Track Classes may appear on 
the menu.
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Why you should read this Chapter
This chapter contains some details about how Cubase handles MIDI. This informa-
tion is vital for making the most out of the program!

MIDI Input 

Standard Interfaces

Cubase records from all active MIDI Inputs at the same time. So which MIDI In-
puts are active? You can make your choices on the “Inputs Enable” pop-up menu in 
the MIDI Setup dialog (which opens when you select MIDI Setup... on the Options 
menu). Normally all Inputs are activated, but you can change this if you need to.

In this example, Cubase will only record from the MPU-401 interface, since the other ports 
are not activated (not ticked).
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In this example Cubase will record from the MPU-401 and the Tahiti Ext. In port.

Normally the MIDI data coming in to the inputs is added together (merged) and re-
corded on one single Track. You do have the option of recording different inputs to 
different Tracks, see the “Multi Track recording” chapter.

About Multi-port Interfaces

If you have a multi-port interface (see Installation), Cubase will record from all its 
inputs at the same time. Cubase does not make a difference between the inputs, it 
sees them all as “one big MIDI connector”.
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MIDI Outputs
Each Track has a MIDI Output setting. This routes the data on the Track to a phys-
ical MIDI Output on one of your MIDI Interfaces.

Standard Interfaces

Standard interfaces are identified in Cubase by the names provided by their respec-
tive drivers (see page 16).

Select one of the ports on the Output pop-up menu to make the Track transmit data to that 
interface.
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Multi-port Interfaces

If you have a multi-port interface, each of its MIDI Out connectors appears as a 
MIDI Output in the Output list. Setting a Track to a certain Output routes all the 
MIDI Data on that Track to that specific MIDI Out connector on the interface.

In the case above, the Track will transmit all its data to MIDI Output number 1 on a Voyetra 
multi-port interface.
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How Cubase records MIDI Channel data
Each MIDI Event that Cubase records has a MIDI Channel number.

If you for example set your MIDI keyboard to transmit on MIDI Channel 5, all the 
notes, Pitch Bend data, program change or whatever you transmit from it, will have 
the MIDI Channel number 5.

This keyboard transmits on MIDI Channel 5.

Some MIDI devices can transmit on more than one MIDI Channel. In this case the 
MIDI input data coming in to Cubase will contain mixed channel numbers.

This keyboard transmits on two MIDI Channels, – 2 and 6. Possibly it transmits each channel 
from one side of a split point.

5 5
5

5 5

2
6

6
2

6
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Cubase stores the MIDI Channel with the Event. If you for example look in List 
Edit (which you will learn about later in this manual), you can see the MIDI Chan-
nel for each Event that has been recorded.

Rechannelizing – The MIDI Channel setting for the Track
When you play back a recording, you want it to be routed to a certain sound in one 
of your synthesizers. Let’s say you have a synthesizer that plays a bass sound on 
MIDI Channel 3. To route a Track to that sound you set it to MIDI Channel 3.

In List Edit you can see 
the MIDI Channel 
stored with each Event.

This Track is set to play 
back on MIDI Channel 3.
- 138 - 



What now happens is that when you hit play Cubase plays back all the data on the 
Track, but when doing so it replaces the MIDI Channel number stored in the Events 
with that of the Track – in this example, MIDI Channel 3!

This replacement is done as part of the playback procedure, that is it does not affect 
the recording permanently. If you check the data on the Track in List edit (as men-
tioned above) all the Events still have their MIDI channel intact.

This is what we refer to as rechannelizing – changing the MIDI Channel of the 
Events on playback.

Rechannelizing is very convenient because it lets you forget what MIDI Channel 
number your keyboard is set to transmit on. Instead, to route a Track to a certain 
sound, you simply set the MIDI Channel number in the Track list in Cubase.

And, if you decide you want to route the Track to another synthesizer, later, the 
only thing you have to do is to change the MIDI Channel setting for the Track.

These Events, on 
different MIDI 
Channels...

3
3

3
33

...get their MIDI Channel 
changed to that of the 
Track, during playback.
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Rechannelizing also works on Thru-put!
The description above only was about what happens on playback. But in fact, Re-
channelizing happens on the data that passes Thru Cubase. 

If you click on a Track to activate it, its MIDI Channel setting is used for rechan-
nelizing the data that passes through the program. This automatically routes your 
playing to the correct MIDI Channel when you are recording, or rehearsing for a re-
cording you are about to make.

If you make 
a Track 
active...

3
3

3
33

...its MIDI Channel value is 
used for rechannelizing 
the data that passes 
through Cubase.

2
6

6
2

6
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Turning off Rechannelizing – MIDI Channel “Any”
There’s one situation where you might not want rechannelizing and that’s when 
you have a Track that contains Events on multiple MIDI Channels. You might for 
example have:

• Recorded with a keyboard that can be “split” so that it transmits on two MIDI 
Channels.

• You might have a guitar synthesizer where each string can transmit on a dif-
ferent MIDI Channel.

• You might have recorded the output of another MIDI sequencer onto a Track 
in Cubase.

• You might have imported a MIDI File of Type 0, which by definition contains 
only one Track, possibly with Events on several MIDi Channels.

In each of these situations you might want to have the Track transmit on all its 
MIDI Channels – the MIDI Channels actually stored with each Event, as described 
above. This would allow you to set up several sounds and play them all from one 
Track.
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To do this, set the Track to MIDI Channel “Any” (the “lowest” value ).

Summary

To summarize: When a Track is set to MIDI Channel “Any”, rechannelizing is 
turned off, and the Events will be transmitted on their original MIDI Channels in-
stead.

These Events, on 
different MIDI 
Channels...

6
6

2
62

...will play back on their 
original MIDI Channels since 
the Track is set to “Any”.
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The Track Columns and the Inspector9
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The Track Columns
The Track columns show names and settings for the Tracks. These settings can be 
changed directly. The headings are the same for all Tracks, but may have a slightly 
different meaning for different Track classes. Not all columns apply to all Track 
classes.

Getting the Track Columns to appear

The Arrange Window is divided into two parts, the Track columns to the left and 
the actual Arrangement display to the right. To get all of the Track columns to ap-
pear, press the mouse button with the pointer positioned above the Divider (the bor-
der between the two parts of the Arrange Window) and drag it as far to the right as 
possible. You should now be able to see all of the Track columns.

The Divider, dragged as 
far right as possible.
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Changing the order of the Track Columns

You can arrange the vertical columns in any order you like, by simply dragging the 
headings to the left and right, respectively.

Press the mouse button with the pointer on the 
heading of the column you want to move.

With the mouse button pressed, drag 
the column to the new position.

Release the mouse button, and the 
column is moved to its new position.
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If you drag to the left, the column will be inserted to the left of the column you 
"drop it on". If you drag to the right it will be inserted to the right of the column you 
"drop it on".

The Activity Column

This column is shown if the checkbox “Activity Display” in the Preferences dialog 
(reached from the File menu) is activated. The column, with the heading “A”, 

 This column is shown only if the checkbox “Activity Display” in the Preferences 
dialog (reached from the File menu) is activated. The column, with the heading 
“A”, shows if any MIDI is being sent out from the Track at the moment. The width 
of each bar represents velocity for notes. The activity column applies to MIDI 
Tracks, Drum Tracks, Group Tracks and Mix Tracks.

● This column can’t be moved!

The Activity Column as it looks when a 
note is played back on the Track.
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The Mute Column

The Mute column is indicated by an “M”. By clicking in this column, you tempo-
rarily “silence” the Track. A black dot is displayed in the column. To make the 
Track sound again, you just click in the Mute column again. This is described in de-
tail in the chapter “Mute and Solo”.

In the basic version of Cubase, muting applies to all Track classes except Tape 
Tracks.

The Class Column

This column is indicated by a “C” and is used to set a Track to a certain Class. See 
page 127 for a thorough explanation.

Click in the "M" column...

...to Mute the Track. The 
black dot indicates that a 
Track is Muted.
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The Time Lock Column

This column is indicated by at "T". If you click in it, a lock symbol will appear.

A Time Locked Track.

Events on Time Locked Tracks are fixed in time. This means that even if you 
change the tempo, the Events will stay at the same positions, time-wise. See the 
chapter “Time Locked Tracks”.

The Track Column

This column shows the Track's name. To enter or change a name, double click in 
this field for the relevant Track.
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The Chn Column

The contents of this column vary depending on the Track class:

The Chn Column for MIDI Tracks, Drum Tracks and Chord Tracks

For these Track classes, the Chn column shows the MIDI Channel set for each 
Track. You may change the MIDI Channel of a Track at any time. For a full expla-
nation of MIDI Channels and the effects of changing them, please read the chapter 
“MIDI Input, Output and MIDI Channels”.

• Chord Tracks do not play back MIDI messages like MIDI Tracks. The 
MIDI Channel value is only used for thruput when you record chord 
changes (see the chapter “Style Tracks”).

The Chn Column for Tape Tracks

For Tape Tracks, the column shows the track on the tape recorder. See the chapter 
“Tape Tracks – Controlling Tape recorders”.

The Chn Column for Group Tracks, Mix Tracks and Style Tracks 

For these Track classes, the Chn value does not apply. The column is therefore al-
ways left blank.
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The Output Column

The function of this column varies with the Track Class:

The Output Column for MIDI Tracks, Drum Tracks and Chord Tracks.

For these classes, the Output column shows which physical MIDI Output each 
Channel uses.

• Chord Tracks do not play back MIDI messages like MIDI Tracks. The 
MIDI Channel value is only used for thruput when you record chord 
changes (see the chapter “Style Tracks”).
To change Output for a Track, position the pointer in 
its Output column, press the mouse button...

...and select the MIDI Output you want 
from the pop-up menu that appears.
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• If you hold down [Control] while you change the Output value, all Tracks 
will get the selected Output value.

● The concept of different MIDI Outputs is fully explained in the chapter “MIDI 
Input, Output and MIDI Channels”. To avoid confusion, please take your time 
and read this section.

The Output Column for Mix Tracks

Mix Tracks do not contain regular MIDI data, and therefore have no corresponding 
MIDI Output. Instead, the Output column is used to decide which Mixer Map the 
Track should use. See the chapter “The MIDI Mixer and Mix Tracks” for an expla-
nation of these concepts.

The Output Column for Group Tracks, Tape Tracks and Style Tracks

For these Track classes, the Output column is not used, and is therefore left blank.

The Instrument Column

In Cubase terms, an Instrument is simply a certain MIDI Channel together with a 
certain Output. Instruments can be defined for MIDI Tracks and Drum Tracks.
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Defining your different MIDI Channel/Output combinations as Instruments can be 
practical, since you can do this once and then not have to mind the actual Channel 
and Output settings. In the Instruments chapter, this concept is more thoroughly ex-
plained.

Using the Inspector

What is the Inspector?

The Inspector is a part of the Arrange Window. It contains a number of value- and 
name fields, where you can change settings and properties of a Track or individual 
Parts on a Track. 

There is one important thing to remember before you start working with the Inspec-
tor:
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● The settings you make in the Inspector will affect the material during play-
back. You do not really change anything recorded.

When you play back notes 
from a Part...

...they pass through the 
Inspector...

...and are output, in this example 
transposed one fifth (i.e. seven 
semitones) upward.

The actual recorded material 
in the Part is not affected.
- 153 - 



Getting the Inspector to appear

You open the Inspector by clicking on the strip with the little Inspector Icon below 
the Track column, or by pressing [Alt Gr]-[I]. An area to the left of the leftmost col-
umn in the Track list appears. In this you find a number of value fields, name fields 
and buttons. These are described in the following pages.
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...to open the Inspector.

Click on the Inspector Icon...

To close the Inspector, click on the Inspector Icon again.
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Changing values in the Inspector

By changing values in the Inspector, you make changes to your Parts and Tracks. 
Some fields are duplicates of fields in the Track list, while others can be found only 
in the Inspector. To get a basic grip of how to use the Inspector, follow the steps be-
low:

1. Open the Inspector.

2. Select a Track on which you have recorded some music.

3. Check that no Parts are selected.
The heading of the Inspector should read “Trackinfo” - otherwise, just click on 
an empty area in the Part Display.

4. Start playback.

5. While the music is playing, try changing the "Transpose" and "Volume" 
values in the Inspector.
The transposition and volume of the played back music will change accord-
ingly.
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Making Real-time changes with the Inspector

When you change the value of a parameter in the Inspector, the new value is imme-
diately sent out to the MIDI Output. This will affect not only the sound source as-
signed to the selected Track, but all MIDI devices connected to the same Output as 
the Track, and set to receive on the same MIDI Channel.

You may use this feature for setting appropriate values (e.g. volume, velocity etc) 
while the music is playing.
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What is affected by the Inspector?
This depends on what is selected in the Arrange window. The following possibili-
ties exist:

When a Track, but not a Part, is selected

When no Parts are selected, the Inspector has the heading “Trackinfo”. The param-
eter values affect the selected Track, and all the recorded material (the Parts) on it.

One Part is selected

The Inspector has the heading "Partinfo". The parameter values affect the selected 
Part only.
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Two or more Parts are selected

The Inspector has the heading "Partinfo", and shows the parameter values of one of 
the selected Parts. If you change a parameter, all the selected Parts will get the new 
value, regardless of their previous settings.
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How Part and Track settings relate

As you have seen, you may change parameter values both for the whole Track and 
for individual Parts on the Track. It is the latest change that “counts”. If you for ex-
ample change the velocity value of a single Part and then set another velocity value 
for the whole Track, the Part will also get this latest velocity value. Other parameter 
settings for the Part will remain unaffected.
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Make various settings for a Part...

...then change the velocity 
value for the whole Track.

Now the velocity value for the Part is 
changed to that of the Track, but the other 
settings for the Part remain unaffected.
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The Fields and values in the Inspector
The Inspector contains names, numerical values and pop-up menus. All these set-
tings can be changed using any combination of mouse and keyboard, as usual. As 
all other changes, these can of course be done while the music is playing and even 
while recording.

The table below contains the different parameters in the Inspector for a MIDI 
Track/Part. For other Track classes, the contents of the Inspector may differ. For a 
more thorough explanation of some of these parameters, see the chapter “Inspector 
Real Time Parameters”.

Parameter Explanation

Track/Part Name The name of the selected Track or Part.

Instrument The Instrument (Output and Channel) that the selected Track 
or Part is assigned to.

Output The Output port for the selected Track or Part.

Chan The MIDI Channel that the Track or Part is playing back on.

Bank Lets you associate a MIDI Bank Select message with a Track 
or a Part, to make a connected instrument switch from one 
"program bank" to another.
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Prg Lets you associate a MIDI Program Change message with a 
Track or a Part, to make a connected instrument switch from 
one sound to another.

Volume A volume value for a Track or a Part. This setting is sent out 
as a MIDI Volume message.

Transp Lets you transpose the notes in a Part or on a whole Track.

Veloc The value in this field is added to the velocity of the notes 
played back.

Delay Delays the notes. With a negative value, Delay will cause 
notes to play earlier instead.

Length Changes the length of the notes by a percentage factor.

Compr Compresses or expands the velocity range of notes.

Pan Sends out a MIDI message, telling your instrument to place 
the sound of the Part/Track in a certain position in the stereo 
field.

Parameter Explanation
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● When the Mode parameter in the GM/GS/XG Editor is set to anything but 
“Off”, the Prg value field shows GM Program names instead of Program num-
bers. 

Clicking on the Prg field in GM/GS/XG mode opens a pop-up where you can select program 
group and name.

When should I use the Track Columns and when should I 
use the Inspector?

Many of the parameters in the Inspector have equivalents in the Track columns. Re-
member the following facts:
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• The Inspector can affect both Tracks and single Parts. The Track columns only 
affect whole Tracks.

• The fields with the same name in the Track columns and the Inspector have 
exactly the same function. Changing the value in one affects the other as well.

Why then use the Track columns at all? Well, for one thing, it is very handy to have 
instant overview and control over all Tracks at the same time. The contents of the 
Inspector will change depending on which Parts you have selected. There may also 
be situations when you want the Part display (to the right in the Arrange Window) 
as large as possible, and therefore need to close the Inspector.
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Real-time Thru
In most recording situations, the Thru function in Cubase is used to “echo” incom-
ing MIDI data via MIDI Out. If you use the Thru function, the MIDI data that you 
send in to Cubase via MIDI In is modified in real-time by some of the Playback pa-
rameters. This means that if you for instance set a transposition value of 7 (semi-
tones) and play your keyboard, all notes coming out via the MIDI Out are 
transposed a perfect fifth upward.

Notes from the keyboard...

...are passed through 
the Inspector...

...and output again, 
transposed one fifth upward.
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This allows you to try out what effect a certain parameter setting will have on the 
music, before and when you record something. Since different Parts can have dif-
ferent settings you must select the right Track and check that the Song Position is 
somewhere within the Part that has the settings you want to try. 

● It doesn’t matter which Part or Track you have visible in Part Info (you may 
have stepped through the Parts and Tracks with the arrow keys on the compu-
ter keyboard), it is only the Song Position and Active Track which determines 
which Part’s settings should be used for the real-time modification. 

The real-time parameters used for modification are: Transpose, Velocity and Com-
pression.

You can also thru-put to up to four Instruments (Outputs and MIDI Channels), see 
the chapter “Multi Track Recording”.

The Part in the "cross" made 
up by the Active Track and 
the Song Position is used for 
real-time "Thruing".
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What is Muting?
Using the Mute function you can silence a part of the music without actually delet-
ing it. This is useful in many situations, since it lets you “take away” a component 
of the music without actually deleting it. You may for example want to try out dif-
ferent variations of an arrangement by muting some parts of the music, or listen 
only to the rhythm section of a song etc.

The Mute function in Cubase resembles that on a regular audio mixing console. 
The difference is that in Cubase, you may Mute not only whole Tracks, but also in-
dividual Parts on a Track.
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Muting a Track

To “unmute” a Track, simply click on the black dot.

● If any notes are sounding at the moment you Mute a Track, they are allowed 
to play until their end.

Clicking in the Mute column...

...silences a Track.

The black dot indicates 
that the Track is Muted.
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Muting a Part

To “unmute” a Muted Part, simply click on it with the Mute tool selected.

Select the Mute tool from the Toolbox.

Click on the Part 
you want to Mute.

The Muted Part.
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What is Solo?
The Solo function works as an “inverted” Mute - that is, if you Solo a Track, all 
other Tracks get Muted. This is useful if you want to listen closely to the contents of 
a Track, and don’t want any other music to interfere. Solo a Track like this:

Click on the Solo button in the upper left corner of the 
Arrange Window to activate Solo.

The highlighted Solo 
button indicates that Solo 
is activated.

All Tracks except the 
currently selected, 
get Muted.

If you select another Track, 
it will get Soloed instead.
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Instead of clicking on the Solo button, you can type [S] on the computer keyboard. 
You can unmute one or more Tracks while in Solo mode if you want to hear, for ex-
ample, just how two or three Tracks sound together.

To deactivate Solo, click on the Solo button (or type [S]) again. All Tracks will re-
turn to the Mute status they had before Solo was activated.

Pre-programming Mutes
You can define and store up to ten Track Mute settings. These can be used for in-
stant recall of any combination of muted Tracks.

1. Mute the Tracks you want Muted.
You can use either the Mute function or the Solo function, as described ear-
lier.

2. Hold down [Shift] and  [Alt Gr] (the right Alternate key) and press one of 
the function keys [F2] to [F11].
The Mute setting is now stored under that key.

3. To recall a setting: Hold down  [Alt Gr] and press the corresponding func-
tion key  ([F2] to [F11]) .
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Recording Mutes and Solo

It is possible to record Mutes and Solo, just like any regular MIDI data. This is de-
scribed in the chapter “Recording Mutes and Solo” in the “Getting into the Details” 
book.
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About Parts and arranging
As you have already seen, a Cubase Arrangement is roughly structured in three 
“levels”: Several Tracks, each containing a number of Parts which in their turn 
contain Events (notes and other MIDI data). This chapter is about arrangement ed-
iting - in other words, the re-arranging of the larger building blocks, Parts and 
Tracks. This is done in the right part of the Arrange Window, the area called the Part 
Display.

The Arrange Window with the Part Display to the right.
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Selecting Parts
As with all elements in Cubase, you have to select a Part to be able to move, delete 
or in any way manipulate it. Selecting a Part can be done in several different ways:

By clicking

Clicking on a Part with the Arrow tool...

...selects it...

...and deselects all 
other selected Parts.
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By shift-clicking

Clicking on a Part while 
holding down [Shift]... ...selects the Part.

The previously 
selected Part(s) 
remain 
selected.
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By using the computer keyboard

Pressing the right 
arrow key on the 
computer keyboard...

...selects the next Part 
on the same Track.
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By enclosing them in a rectangle

Press the mouse button with the pointer somewhere in an empty part of the Part Display...

...and drag the mouse with the button pressed. A dotted outline of a rectangle is shown.

When you release the mouse 
button, all Parts that were 
enclosed or “touched” by the 
rectangle, become selected.
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If you hold down [Shift] when you start to drag, you don’t have to have the pointer 
in an empty area, you can start with the pointer positioned over a Part.

By using the Edit menu

On the Edit menu you will find an item called “Select” which brings up a sub-menu 
with a number of options that allow you to select all Parts on a Track, all Parts in the 
Arrangement, to invert the current selection etc.

• You can also select all Parts by pressing [Control]-[A] on the computer key-
board.
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• You can also select all Parts on a Track, by holding down [Shift] and double 
clicking anywhere on that Track.

Deselecting Parts

There are two principal ways to deselect already selected Parts:

1. If you hold down [Shift] and click on a Part...

...the Part gets deselected. The other selected Parts remain selected.
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2. If you instead click in some empty area in the Part Display...

...all selected Parts get deselected.
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Manipulating Parts

About the Snap value

When you are moving, duplicating or changing the length of Parts, the result of 
your actions depends on the Snap value. 

Pulling down the Snap pop-up menu.

This value determines the smallest distance you can move a Part. The table and fig-
ure explains it more clearly:

Value Description

Off Any position can be used.

Bar Movement is restricted to exact bar lines.

1/2 to 1/16 Movement is restricted to the selected 
note value.
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If Snap is set to Bar...

...Parts can only be dragged 
to exact bar lines.

If Snap is set to for example 1/4...

...Parts can be put on any 
quarter note position.
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Moving Parts

You can move one or more Parts to a new position on any Track. Remember that the 
Snap value determines where you can place the Parts.

1. Press the mouse button with the pointer over the selected Parts you want 
to move. 
The pointer takes on the shape of a hand.
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2. Drag the Parts to their new position.

3. .Release the mouse button. 
The Parts are moved. Note that the relative distances between the moved 
Parts are kept intact.
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Duplicating Parts

To duplicate Parts hold down the [Alternate] key on the computer keyboard and 
proceed exactly as when moving. You may move the duplicate to any position on 
any Track.

When you hold down [Alternate] and drag a 
Part to a new position...

...a duplicate of the Part, complete with 
contents, is placed at the new position.

The original 
Part is not 
affected.
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Another way of moving or duplicating Parts is to use Cut/Copy and Paste. These 
functions are described in the chapter “Basic Methods”.

Using the Toolbox

You can perform a number of operations on Parts using the tools available in the 
Arrange window’s Toolbox. Each tool is briefly described below. For more detailed 
information, see the chapter “The Arrangement – Part and Track Operations”.

● Remember that any operation that deals with the length or position of a Part, 
also is affected by the Snap value.

The Pencil Tool

The Pencil tool can be used to create new, empty Parts, by “drawing” them in the 
Part Display. You can also use the Pencil to change the length of a Part.

Clicking on the outline of a Part and 
dragging it with the Pencil changes 
its length.
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The Eraser Tool

Click on a Part with the Eraser tool to delete it. If you hold down [Alternate] and 
click on a Part with the Eraser tool, this Part and all the consecutive Parts on the 
Track will be deleted. Other ways of deleting Parts are described on page 192.

The Scissors Tool

The Scissors tool is used to split one Part into two. The two Parts will have the same 
name as the original Part.

The Magnifying Glass Tool

With this tool, you can perform what is known as “Scrubbing”. By clicking and 
dragging the Magnifying Glass over a Part, you can monitor its contents (the 
Events in the Part are output).

Clicking with the Scissors on a Part, divides it in two.
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The Glue Tube Tool

This works as the opposite of the Scissors tool: If you click on a Part with the Glue 
Tube, you “glue together” that Part and the next Part on the Track. The resulting, 
longer Part will have the name of the first Part. The two Parts do not have to adjoin.

Before and after gluing two Parts together.

The Match Quantize Tool

This tool is described in the chapter “The Arrangement – Part and Track Opera-
tions”.
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The Mute Tool

Use this tool to Mute Parts. See the chapter “Mute and Solo”.

Deleting Parts
There are several ways to get rid of unwanted Parts.

• Select them and press [Backspace] on the computer keyboard.

• Select them and use Delete Parts on the Edit menu.

• Click on the Parts with the Eraser tool.
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Part Appearance

You can choose how the Parts should be displayed, using the Part Appearance sub 
menu on the Options menu. There are three choices:

Show Names

Parts are shown as boxes with names.
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Show Events

Parts are shown as boxes with vertical lines representing the MIDI Events. You may 
define which types of Events should be displayed, by turning on and off the flags in 
the Part Appearance sub menu.

Show Frames

Parts are shown as empty boxes.

In this example, only Notes, After Touch 
and Pitch Bend Events are displayed.
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Part Color

To distinguish Parts, you may give them different colors. You have a choice of 
seven user definable colors.

Adding Color to all Parts on a Track

1. Make sure no Parts are selected.

2. Click on the Track name in the Track list to activate that Track.

3. Select the desired color from the Part Color pop-up.
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Adding Color to some Parts

1. Select the Parts.

2. Select the desired color from the Part Color pop-up.

The Part Color pop-up is found 
above the Part Display.

Choosing one of the colors from 
the menu adds color to the Parts.

Click here to edit the 
colors and names.
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Naming the Arrangement
As you have seen, you can work with several different Arrangements within a 
Song. You can give names to each of your Arrangements. Simply use the right 
mouse button, click on the leftmost part of the Arrange window’s Title bar, to the 
right of the Control menu button, and type in a new name.

Renaming an Arrangement.

If you choose to save an Arrangement to disk as a separate file, then the name you 
give it while saving will be used as the Arrangement’s title next time you load it.

Clicking in this area with the right 
mouse button...

...opens a name box where you can 
type in the new name.
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What can I do with the MIDI Editors?
When you record MIDI data, you fill Parts with notes and other MIDI “Events”. 
But you don’t really get to see and manipulate those Events individually from the 
Arrange window. In the MIDI editors you do!

Different types of Events and where to find them
Below we’ll list the different types of MIDI data that Cubase can record, and how 
and where they are displayed for editing:

Notes (Note On and Off messages)

Notes are displayed in all MIDI editors. Let’s look at a simple drum pattern and 
how it is shown in the different editors:
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In Drum Edit

In the Drum Edit window, the notes are shown as diamonds. 
Each key corresponds to a Sound, as listed to the left. The different 
shadings of the diamonds indicate different velocity values.
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In Key Edit

The notes are shown as boxes, with higher notes higher up in the grid. 
Since this is a drum pattern, all the notes are short, but otherwise note 
length is indicated by the width of the rectangle.

The piano keyboard to the left is there to make it easy to 
find the right pitch when inputting or editing notes.
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In List Edit

The notes are shown both in the list to the 
left, and in the graphic display to the right.

The black bar graphs are for graphically displaying 
and editing MIDI “Value 2” in every Event. In the 
case of notes, “Value 2” is the velocity value.
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In Score Edit

Continuous Messages

In MIDI, various types of MIDI messages are used to transfer continuous changes. 
To be exact, these types are:

• Aftertouch (Channel Pressure and Poly Pressure).
• Pitch Bend.
• Controllers, like sustain pedal, MIDI Volume, Modulation wheel etc.

To be really exact (not to say pedantic!) some of these are not really continuous. 
Sustain Pedal for example can only be down (On) or up (Off). However, the MIDI 
specification groups all these messages as “Continuous”, and so does Cubase.

In Score Edit, notes are displayed and edited just as notes on a 
printed score. This snapshot is taken from Cubase Score.
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Continuous messages are shown and edited in Key Edit and List Edit:

In Key Edit, the area beneath the Divider is the Controller Display.

Clicking on this icon brings up a pop-up menu, allowing you to 
select which type of continuous data should be shown. In this 
case, modulation wheel Events are displayed.
- 204 - 



The modulation 
Events are listed in 
their playback order.

Value 2 for each Event is shown in the 
list and in the bar display. The grey 
color indicates non-note Events.

The “mountains” of continuous data (as shown in the Key Edit Window) are in reality 
a large number of single Events. This becomes clear when looking at the same data in 
the List Edit Window:
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Program Change messages

A Program Change message is a MIDI Event, telling a connected MIDI device to 
switch to another Program (e.g. a sound in a synthesizer, a setting in a reverb de-
vice, etc). You can record Program Change messages into Cubase like any other 
Event. If you want to edit (or create new) Program Change messages, it can be done 
in Key Edit or List Edit.

System Exclusive messages

System Exclusive messages are a special kind of MIDI Events, intended for de-
tailed control of the parameters of a MIDI device. Since all devices have different 
parameters, each major manufacturer of MIDI devices has a special ID code that is 
included in the System Exclusive message.

System Exclusive messages are displayed and edited in the List Edit window. See 
the “List Edit” chapter.
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Opening An Editor

By double clicking on one Part

Which editor opens depends on two things:

• The Track Class (Drum Tracks open the Drum editor etc.)
• The “Double Click Opens” Preference setting (see below).

If you only want to open one Part into 
an editor, simply double click on it.
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Setting the preferred Editor for MIDI Tracks

For MIDI Tracks you can yourself decide which editor you get with a double click.

1. Open the Preference 
dialog from the File menu.

2. Change the Double 
Click Opens setting.

3. Save the Song.
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Editing a complete Track

You can edit all Parts on a Track at the same time:

For MIDI Tracks, the “Edit “item opens Key Edit.

1. Make sure no Parts are selected, by clicking 
somewhere in an empty area of the Arrange Window.

2. Select the Track you want 
to Edit.

3. Select the preferred editor from the Edit 
menu or use the keyboard equivalents.
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Editing more than one Part

You can edit any selection of Parts, even Parts on different Tracks at the same time. 
The only restriction is this:

● List Edit can only be used to edit Parts that are all on the same Track.

1. Select the Parts you want to Edit.

2. Select the preferred editor from the Edit menu or use the keyboard 
equivalents.
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If you haven’t recorded any Part yet

You might want to open the editor to input notes from scratch, without recording 
anything first:

1. Select the Pencil from the Toolbox.

2. Draw in a Part where you want it. 

3. Double click on the newly created Part 
or use the Edit menu as described above.
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About Recording and Playback
Basically, anything you can do in the Arrange window that relates to playback and 
recording, you can also do in the editors.

Realtime

As everything else in Cubase, editing can happen in realtime. This means that you 
can edit while the music is playing or actually even while you are recording!

Step Recording

If you prefer not to record your music in real time, you may use the Step Recording 
function to input music one note at a time. This is explained in the chapter “Step 
Recording”.
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Follow Song

If Follow Song on the Options menu is turned on, the Edit window will scroll auto-
matically during playback, so that the current Song Position is always visible.

• You may also press [F] on the computer keyboard to turn Follow Song on 
and off.

Edit Solo

When this button is activated, you will only hear the Track/Parts that are currently 
being edited. All other Tracks are muted. Use this function when you want to con-
centrate on editing the Parts in the editor, rather than hearing the recording in a con-
text.
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Cycle

If the Cycle button on the Transport Bar is activated, a certain section of your ar-
rangement will be repeated over and over as described in the chapter “Cycled Play-
back and Recording”. This is very handy for editing where you can fine tune a 
recording and instantly hear the result without having to Rewind and Play to get to 
the right section.
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Key Edit
Below you will find a description of some of Key Edit’s main features:

The black notes are 

The position of the mouse pointer 
is shown both on the Piano 
keyboard and in the Mouse Box.

The Song Position 
Pointer.

Clicking here opens the Controller Display.

The Snap and Quantize boxes.

The Goto pop-up is used 
for moving the view.

The Do and To pop-ups. See “The 
MIDI Editors – General Information”
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Score Edit

Overview

Below you will find a description of some of Score Edit’s main features:

The “inverted” notes are selected.

The Song Position Pointer.

The mouse position is shown both in the mouse box and as a 
note name in the box below. When you move a note, the 
lower box shows the amount of transposition in semitones.

If you are editing Parts on several Tracks at the same 
time, the striped double bar line at the beginning of 
the score indicates the Active Track.
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Getting the Score displayed correctly

When you open Score Edit, your notes may not look as legible as you would ex-
pect. There are a number of settings you can do to make the Score look good. See 
the Score Edit chapter for more information.

Window Size

Score Edit’s Edit mode displays as many notes as there is room for in the window. 
In other words, to see more or less of your Track, simply resize the window.
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Page Mode vs Edit Mode

If you are using Cubase Score or Cubase Audio, your program will have a Score 
menu. The top item on this menu is used to switch the Score editor between its two 
modes, “Page” and “Edit”.

Selecting Page Mode will display the 
music as it will look when printed...

...while Edit Mode displays the music in a 
way more suitable for editing, see below.
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We recommend you to select Edit Mode for regular editing of MIDI recordings. 
The text below assumes the editor is set to Edit mode. The other mode is for score 
layout and printing.

Users of the regular Cubase (not Score or Audio) do not have to worry about this.
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Drum Edit
Drum Edit can be used to edit MIDI Tracks. It can also be used in a more advanced 
context, for editing Drum Tracks. See the chapter “Drum Edit and Drum Tracks”.

Below you will find a description of some of Drum Edit’s main features:

The Song Position pointer.

The Do and To menus. 
See the chapter “The 
MIDI Editors – General 
Information”.

The position of the mouse is shown 
in the Mouse Box. The name of the 
Drum Sound on the corresponding 
line, is shown in the box below.

The Drum Sound list. By dragging the Divider 
further to the right, more columns are shown.

The black notes are selected.

Clicking here opens the 
Controller Display.
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About the Drum Map

In Drum Edit, each key on your MIDI keyboard is represented as a “Sound”, in a 
“Drum Map”. This map consist of 64 Sounds which can be named and set to repre-
sent a certain drum sound in your synthesizer, sampler or drum machine.

When you have defined a Sound, all notes that are already recorded with that Sound 
will appear as diamonds on that “line” in the note display.

Opening ready-made Drum Maps

You can find a number of ready-made drum maps on one of the Cubase disks. You 
may very well find one there which has been created for the drum sounds in one of 
your instruments. To load a map, proceed as follows:

1. Select Open from the File menu.

2. From the File Format pop-up menu, select “Drumsets (*.DRM)”.

3. Locate the Drum Maps folder on your hard disk or on one of the program 
floppy disks.
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4. Locate the drum map you desire, and click OK.
Now when you next time open the Drum editor, your Drum Map is already 
properly defined and recordings made in the Arrange window should appear 
with all the notes on the right “lines”.

If you save your Song, the selected Drum Map is saved together with the 
Song. It will be loaded automatically next time you open the Song.
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Setting up and changing the Drum Map

If you don’t find a Drum Map suited for your instrument among the ones included 
with Cubase, you can easily change an existing Drum Map, or set up a whole new 
one:

1. Check out and memorize which key on your keyboard is 
used to play a certain Sound.

2. Open the Drum editor and drag the Divider between the Drum Map 
and the Note display so that you see the first few columns in the list.
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Now, recordings made with the Sound played by that key will appear on that line.

3. Double click on a 
Drum Name and type 
in your own.

4. Double click on the I-note 
value for that Sound, and 
type in the pitch of the key 
that plays the Sound.
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If already recorded Notes don’t appear on the Line

It may happen that you have defined an I-Note correctly and still, no notes appear 
although they play back correctly. If this happens it is because more than one 
Sound is set to the same I-Note. Proceed as follows:

1. Scroll up or down the List to find a Sound set to the same I-Note as the 
one you want to use.

2. Scroll the I-note value of the Sound you just located to its lowest possible 
value (C-2).

3. Scroll back to the original Sound and check again.
The notes should now have appeared.
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If you get the “Double defined Notes” message

When you change the I-note value, a dialog box may appear saying “Double de-
fined I-NOTE in your drum set”. This means that more than one Sound is set to re-
spond to the same MIDI Note, as described above.

This dialog will appear every time you open Drum Edit, until you change one of the 
identical I-note values.
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List Edit

Overview

The Song Position is shown both in the Event list 
and in the Event display

In the Insert pop-up menu, you 
decide which type of Events to input.

The Events are shown in the list 
and in the display to the right.

The Mask pop-up is used to make List 
Edit show Events of a certain type only.

The Mouse position is 
shown in the Mouse Box.

The Do, To and Goto 
menus.
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To make all columns appear, drag the Divider as far right as possible.
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About selecting in the Editors
• Selecting Notes and other Events in the main Event displays is done exactly 

like when selecting Parts in the Arrange window, see the previous chapter.
• Selecting Events in the List in List Edit can be done by clicking and Shift-click-

ing.
• You may use the Select sub-menu in the Edit menu to select Events. The con-

tents of this sub-menu varies depending on which editor you are in. See the 
Online Help for more information.

• Selecting in the Controller Display in Key and Drum Edit is slightly different. 
See the chapter “The MIDI Editors – General Information”.

About Snap
The Snap Value is used in the editors just like in the Arrange window, that is for re-
stricting movement to certain note positions.
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Using the Tools

The Toolboxes of the different Edit Windows. The Score Toolbox shown above is from Cubase. 
The “Score” and “Audio” versions have a different one.

The Arrow Tool

Moving Events

Just as in the Arrange window, notes (and in List Edit – other Events too) can be 
dragged around as desired.

Key Edit

Score Edit

Drum Edit

List Edit
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Duplicating Events

Again like in the Arrange window, if you hold down [Alternate], the notes you drag 
will be duplicated.

The Eraser

This is used to delete notes and other Events in the graphic displays. Click and/or 
drag over the notes you want to delete.

The Pencil/Drum Stick (in Key, Drum and List Edit)

Entering Notes in Key and Drum Edit

1. Set the Snap value to the smallest position you want to enter a note at.
For example if you only want to enter notes at quarter note positions, set Snap 
to “4”.
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2. Set the length of the note to enter by changing the Quantize value.
If you for example set this to “8” you will input eighth notes. You may also 
change the length while you’re drawing - see page 235.

The Snap and Quantize values set to 4 and 8, respectively.

3. Select the Pencil/Drum Stick tool from the Toolbox.
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4. Move the pointer onto the note display, aiming at the correct position.

5. Click once with the mouse. 
The note appears.

Two fields on the Status Bar will help you by showing the position and 
Pitch/Sound you move the pointer over.
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Entering Events in List Edit

1. Use the Insert pop-up menu to 
decide what type of Event to Insert.

2. Set the Snap value to the smallest 
position you want to enter a note at.

3. If you are entering notes, set the length with 
the Quantize value. If you for example set this 
to “8”, you will input eighth notes.

4. Click with the Pencil tool in the Event Display. Use 
the ruler to find the right position.

The Event appears both in 
the Event Display and in 
the List.
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Setting the length while drawing (Key and List Edit only)

In Key and List Edit you have the option to set the length of notes to something else 
than the quantize value, while entering them. Still the Snap value applies so you 
can only set the Length to even multiples of this value.

1. Aim with the Pencil at the correct position and pitch.

2. Press the mouse button and drag to the right with the button pressed.

3. Release the mouse button. The Event is adjusted to the closest Snap value.
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Determining the note’s velocity

The Note you click in have a fairly high velocity. In Key, List and Drum Edit you 
can change it by holding down modifier keys while clicking. First let’s look at Key 
and List Edit:

In Drum Edit things are a little bit different. For each Sound in the List you can set 
four velocity values for note input which are then each represented by a modifier 
key, and displayed graphically with four different diamond symbols in the display.

Velocity Modifier key

High None

Medium - high [Shift]

Medium [Control]

Low [Shift]+[Control]

Symbol Velocity value / 
column in Sound List

Modifier

Level 4 None

Level 3 [Shift]

Level 2 [Control]

Level 1 [Shift]+[Control]
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The Brush Tool (Key, Drum and List Edit)

This is used for continuous “painting” of notes, and in List Edit also other Events. 
It is described on in the chapter “The MIDI Editors – General Information”.

The Note Tool (Score Edit)

This is used to enter notes in Score Edit, pretty much as with the Pencil in Key Edit. 
The shape of the Note tool changes depending on which note value you are insert-
ing.
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Finding the right Pitch

To easily enter notes with the correct pitch when drawing notes in Score Edit, pro-
ceed as follows:

1. Set up Snap and Quantize and select the right tool.

2. Press the mouse button 
somewhere in the display.

3. With the mouse button down, drag the 
note up/down. Accidentals appear to 
show you the exact pitch of the note.

The pitch is also shown in the 
value field under the Mouse Box.

4. When you have the note at the right note line with 
the correct accidental, release the mouse button.
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The Rest Tool (Score Edit)

This is used for inserting rests between notes. As with the Note tool, the Rest tool 
changes appearance depending on the chosen note value. See the Score tutorial.

The Magnifying Glass

If you click on an Event with the Magnifying Glass, it is played back. You can also 
drag over Events to play them back one after the other.

The Kickers (Key, Drum and List Edit)

These tools are used to move an Event one Snap value in either direction.
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The Cross-hair (Key and Drum Edit)

This tool is only used in the Controller Display, see below.
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Editing Velocity in Key, Drum and List Edit

Showing/Hiding the Controller Display in Key and Drum Edit

There are two ways to bring out/hide the Controller Display:

• Click on the Controller Display button in the lower left corner of the 
window.

• Press [Alt Gr]-[C].
- 241 - 



Changing the size of the Controller Display

Drag the Divider up or down to enlarge or 
shrink the Controller Display.
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Making the Controller Display show velocity

The Controller Display can show various types of data, one of them being note ve-
locity. To select velocity proceed as follows:

1. Position the pointer on the Event type 
icon (in the Controller Display) and press 
the mouse button.

2. Select Velocity from the pop-up menu.

3. Release the mouse button. The 
velocity values are shown as bars, 
with higher bars representing 
higher velocity values.
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The Controller Display in List Edit

The Controller Display in List Edit is on the right-hand side of the window. This 
area works pretty much as the Controller Display, only it is vertical rather than hor-
izontal.

Editing Velocity Values

With the Pencil

To change a series of values, drag over them.

The Controller Display.

Simply click on the velocity 
bar with the Pencil...

...to change its value.
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With the Line Tool

To create a ramp of values, for example a fade-in or fade-out, proceed as follows:

1. Select the Line tool.

2. Position the pointer and press the mouse button.

3. “Draw” the outline of the ramp with 
the mouse button pressed.

4. Release the mouse button. The 
velocity values are changed.
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Continuous Data in Key and Drum Edit

Opening the Controller Display

This is described on page 241.

Making the Controller Display show the right Data type 

The Controller Display can show  several types of continuous MIDI data, but only 
one at a time, of course. You decide which one yourself:

The Event Type icon opens a 
pop-up, where you can 
select the type of data to be 
displayed.
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Editing the Values

With the Pencil

To change one value with the Pencil, simply click on it.

To change a series of values, drag over them.
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With the Line Tool

Adding new Events

1. Select what type of data you want to add.

2. Set up the Snap value to decide what “density” you want for the Events.

“Draw” a line with the Line tool...

...to create a ramp of values.

If you for example want to input one Event 
every eighth note, set the Snap value to “8”.
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3. Hold down the [Alternate] key.
From here on there are basically three ways to go:

4. Release the [Alternate] key.

If you want to enter just one Event, click once with the Pencil.

If you want to “paint a curve”, 
drag the Pencil (with the mouse 
button pressed).

If you want to create a perfect ramp, use the Line tool as described above.
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About the Info Line
At the top of each editor (except List Edit), you have the Info Line. This can be 
shown/hidden with the Info button.

The Info Line shows the values for one selected note. The values can be edited, just 
as in the List in List Edit.

When the “i” button is lit, the Info Line is shown.
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Closing the Editor
There are two ways of closing the editor, “Cancelling” and “Keeping”.

Cancelling

If you press [Esc] (escape) on the computer keyboard or select “Cancel” from the 
Edit window’s Control Menu (reached by clicking on the Control Menu button to 
the left on the window’s title bar), the editor and all the changes you made since 
you last opened it are discarded.

• If you don’t have checked the “Fewer Alerts” check box in the Prefer-
ences dialog (on the File menu), a dialog box allows you to change your 
mind:

Cancelling can be thought of as a super-undo. It allows you to try out a series of 
changes to a recorded piece of music and then easily revert back to its original state.

“Cancel” will cancel all changes you have 
made since you opened the editor.

“Keep” will exit the editor, but 
keep your changes.
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Keeping

If you close the editor by  selecting “Keep” from the Control Menu or by pressing 
[Return], the window closes and all the editing you have made is kept.

The “Keep Appended Events?” Dialog

If you close the editor and a dialog appears asking you if you want to “keep ap-
pended Events”, this is because you have added Events outside the Part(s) being ed-
ited.

• If you click “Yes”, the Part will be extended to encompass the added Events.
• If you click “No”, the Events outside the Part will be discarded.
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Quantizing and Using Functions 13
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How Functions are applied
By using “functions” you can perform various operations on notes and other MIDI 
Events. Some of the most important functions, such as the different types of Quan-
tization, can be found on the Functions menu on the menu bar. In addition, the edi-
tors have their own “miniature” Functions menus, called the “Do” menus.

The main Functions menu and one of the Do menus – they both contain “functions”.

However, before explaining how the functions work, it is important to know exactly 
what is affected by a function:

In the Arrange Window

If you use a function from the Arrange window, it will apply to all selected Parts. If 
there are no selected Parts, the function will apply to all Parts on the active Track.
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In the Editors

All the editors feature a pop-up menu called “To”. There you can decide which 
Events should be affected by a function. The menu options are explained in this fig-
ure:

All Events, active or 
inactive, will be 
affected.

This option has to do 
with the Loop feature, 
which is described in 
“An Introduction to the 
MIDI Editors”.

This option has to do with the Loop 
feature which is described in “An 
Introduction to the MIDI Editors”.

Only the selected 
Events inside the 
Cycle are affected.

All active or inactive 
Events inside the 
Cycle (between the 
left and right 
locators) will be 
affected, whether 
the Cycle is on or 
off.

All selected Events, 
active or inactive, 
will be affected.
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Quantizing

What is Quantizing?

Quantizing in its fundamental form is a function that automatically moves recorded 
notes, positioning them on exact note values: 
If you for example record a series of eighth notes, some of them 
may end up slightly beside the exact eighth note positions.

Quantizing the notes with the Quantize value set to eighth 
notes will move the “misplaced” notes to exact positions.
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The Quantize value concept may need some explanation. By setting this value, on the 
pop-up menu on the Status Bar, you select the exact positions the notes should be moved 
to when you quantize. These are the options:

The effect of the different Quantize values is explained in the illustration on the 
next page.

If you select OFF, no quantizing 
will be done.

In the left column, you select 
Triplet (T) Quantize values.

In this example a Quantize value of 
eighth note triplets is selected.

In the middle column you select regular 
Quantize values. The available values range 
from 1 (whole note) to 64 (1/64 note).

In the right column, you select 
dotted (.) Quantize values.
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Quantizing with different Quantize values

Quantizing with an eighth note triplet 
Quantize value moves the each second 
eighth note, creating a triplet shuffle beat.

Quantizing with a dotted eighth note Quantize value 
moves notes to positions three sixteenth notes apart.

Quantizing the eighth note pattern with a quarter note Quantize value, 
will move every second eighth note to even quarter note positions.

It is important to realize that there will now be two notes on each 
beat! This may cause strange sounds, increased volume etc. 

Start with a straight eighth note pattern.
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Actually, quantizing in Cubase is more than just correcting errors, it is a creative 
feature. On the Functions menu, there are several types of quantization. The three 
most important ones are described in this chapter. The rest are described in the On-
line Help.

● Only notes are Quantized, not other types of Events.
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Over Quantize

This is a very musical version of the standard “auto correct” quantize. Over Quan-
tize will move notes to the closest quantize value, without changing the length of 
the notes. But it also detects and holds together chords (see the figure below) and if 
you consistently play behind of, or ahead of the beat, it uses this fact when finding 
notes to move. In most situations, Over Quantize is probably the most suitable 
Quantize function to use.

• Over Quantize can be selected from the computer keyboard by pressing 
[Q].

When you Over Quantize (in this example 
with a quantize value of 4), Cubase 
realizes that the three notes are a chord, 
and holds them together.
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Iterative Quantize

If you want to straighten up the timing of your notes a little, but don’t want the pre-
cise feel you get from using Over Quantize, Iterative Quantize is probably the best 
bet. It works like this:

Instead of moving a note to the closest quantize value, Iterative Quantize moves it 
only part of the way. You can specify how much the notes should be moved towards 
the selected quantize value in the dialog box that appears when you select Setup 
Grooves... from the Functions menu.

In the same dialog you can also set a value in ticks (0 to 192) called Don’t Quan-
tize. Only notes further away than the specified Don’t Quantize value are moved. 
This lets you allow a certain amount of loose timing, while still being able to 
straighten out really “off” notes.
- 261 - 



Creating a Shuffle Feel using Iterative Quantize

To show the difference between regular quantizing and Iterative Quantize, let’s 
look at two identical eight-note patterns:
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The upper set of notes are Over 
Quantized to eighth note triplets...

The upper pattern gets a heavy, precise triplet feel...

...while the lower pattern gets a more jazzy, natural shuffle feel.

...while the lower set of notes are Iterative Quantized 
using the same Quantize value. Strength is set to 66%. 
(Don’t Q is set to 20, but doesn’t really matter in this case.)
- 263 - 



Groove Quantize

This type of quantizing is not meant for correcting errors, but for creating rhythmic 
feels. This is done by comparing your recorded music to a “Groove Map” (a pattern 
with a certain feel) and moving the appropriate notes so that their timing matches 
the one of the Groove Map. You can for example easily create the shuffle feel from 
the Iterative Quantize example above, using a suitable Groove Map instead.

You select a Groove Map from the Groove Quantize sub-menu on the Functions 
menu. As you see, there are more than a dozen Groove Maps included with Cubase 
from the beginning, but you can also load new ones from disk or make up your 
own, as described in the Online Help.
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The DNA Grooves used in Cubase are derived from the “feel” of real, live record-
ings. These are analysed and a timing template plus a number of Motions - varia-
tions on the basic Groove for different purposes - are created. More DNA Grooves 
are available as separate products.

The Grooves included 
with Cubase are 
described in detail in a 
ReadMe file in your 
Cubase directory.
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Undoing Quantize

● Quantizing is not definite or irrevocable - not even after saving to disk! You 
can always re-quantize to any value, even to Off, unless you specifically 
“freeze” your Quantize, with “Freeze Quantize (Functions menu). 

This means that notes quantized to eighths can later be quantized to sixteenths. The 
original (un-quantized) positions of the notes are used for determining how notes 
should be moved, except when using Iterative Quantize. You can re-quantize just 
some notes in one of the Edit windows.

To completely restore quantized Events to their original positions, use the Undo 
Quantize function on the Functions menu. This can be applied to any selection of 
Parts or individual Events, just as all Functions (see page 254).

Automatic Quantize - Getting your music quantized while recording

This is a function that allows you to have everything automatically Quantized as 
you go along with your recording. When automatic Quantize is activated, every-
thing you record is Over Quantized immediately. The quantization can be undone, 
just as usual.

Automatic Quantize activated.
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The AQ Button (above the Click button on the Transport Bar) turns on and off Au-
tomatic Quantize. You can also press [Z] on the computer keyboard to activate/de-
activate.

● There is one thing to note. If you have this function activated, your recording 
gets Over Quantized at the end of each Cycle. Even if you select some other 
type of Quantizing (like Groove Quantize) during the Cycle, the music will be 
Over Quantized at the end of the Cycle. So, before you manually Quantize, 
turn Auto Quantize off.

Other Functions
The Functions menu is not only used when quantizing, it contains a lot of other 
functions as well. In addition the “Do” menus in the editors contain useful editing 
functions. The same rules as for Quantizing are used to decide what gets affected. 

The various functions on these menus are described in theOnline Help.
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